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Safety warning notice

A WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on a
hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer
and the AC adapter comply with the user-accessible surface temperature limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description HP ProBook HP ProBook  HP ProBook
4520s UMA  4520s 4720s
discrete discrete
Product Name HP ProBook 4520s Notebook PC \/ \/
HP ProBook 4720s Notebook PC 3
Processors Intel® Core™ processors:
e i7-640M, 2.80-GHz (Turbo up to 3.46 N ~ ~
GHz), 4MB L3 cache
e i7-620M, 2.66-GHz (Turbo up t0 3.33 3 3
GHz), 4MB L3 cache
e i5:580M, 2.66-GHz (Turbo up to 3.33 N ~ ~
GHz), 3MB L3 cache
e i5560M, 3.20-GHz (Turbo up to 3.06 N \/ v
GHz), 3MB L3 cache
e i5-540M, 2.53-GHz (Turbo up to 3.06 J y y
GHz), 3MB L3 cache
e i5-520M, 2.4-GHz (Turbo up to 2.93 J y y
GHz), 3MB L3 cache
o i5460M, 2.53-GHz (Turbo up to 2.80 \ v
GHz), 3MB L3 cache (select models ony)
o  i5450M, 2.40-GHz (Turbo up to 2.66 v v v
GHz), 3MB L3 cache (select models ony)
e  {5-430M, 2.26-GHz (Turbo up to 2.53 V y
GHz), 3MB L3 cache (select models ony)
e i3-380M, 2.53-GHz, 3MB L3 cache N N N
(select models ony)
o i3-370M, 2.40-GHz, 3MB L3 cache ~ ~ ~
(select models ony)
o i3-350M, 2.26-GHz, 3MB L3 cache RN N v
(select models only)
o  i3-330M, 2.13-GHz, 3MB L3 cache v N v

(select models only)

Intel Pentium® processors:
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Category Description HP ProBook HP ProBook  HP ProBook
4520s UMA 4520s 4720s
discrete discrete
e P6200, 2.13-GHz, 3MB L3 cache v v \/
(select models only)
e P6100, 2.00-GHz, 3MB L3 cache N ~ N
(select models only)
e P6000, 1.86-GHz, 3MB L3 cache N \ N
(select models only)
Intel Celeron® processor:
e  P4600, 2.00-GHz, 2MB L3 cache N v v
(select models only)
e P4500, 1.86-GHz, 2MB L3 cache N \ S
(select models only)
Chipsets Intel HM57 Express y J J
Graphics Intel HD Graphics \/
Intel Universal Memory Architecture (UMA)
graphics subsystem integrated with shared
video memory (dynamically allocated)
ATI Mobility Radeon HD 6370 with 1-GB \ y
memory
ATI Mobility Radeon HD 5470 with 512-MB \ y
memory
ATl Mobility Radeon HD 530v with 512-MB v \
memory
Panels All display assemblies support privacy filter 3 \/ J
15.6-in HD LED backlight panel: 3 J

o  1366x768 AntiGlare
o 1366x768 AntiGlare for webcam

e 1366x768 AntiGlare for webcam and
WWAN

e 1366x768 BrightView
e 1366x768 BrightView for webcam

e 1366x768 BrightView for webcam and
WWAN

o 1366x768 HD+

o  1366x768 HD+ for webcam
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Category

Description

HP ProBook
4520s UMA

HP ProBook
4520s
discrete

HP ProBook
4720s
discrete

17.3-in HD LED backlight panel:

1600x900 AntiGlare

1600x900 AntiGlare for webcam and
WWAN

1600x900 BrightView for webcam

1600x900 BrightView for webcam and
WWAN

\/

Memory

2 customer-accessible/upgradable memory
module slots

<

Supports dual-channel memory

Supports up to 8 GB of system RAM

PC3-8500, 1066-MHz, DDR3

Supports the following configurations in all
countries and regions:

8192-MB total system memory (4096-
MB x 2)

4096-MB total system memory (4096-
MB x 1)

4096-MB total system memory (2048-
MB x 2, dual-channel)

3072-MB total system memory (2048-
MB + 1024-MB, dual-channel)

2048-MB total system memory (2048-
MB x 1)

2048-MB total system memory (1024-
MB x 2, dual-channel)

1024-MB total system memory (1024-
MB x 1)

< | 2| 2| <

< | 2| <2 | =2

< | 2| <2 | <2

Hard drives

Supports 9.5-mm, 6.35-cm (2.50-in) hard
drives

\/

Customer-accessible

Serial ATA




Category

Description

HP ProBook
4520s UMA

HP ProBook
4520s
discrete

HP ProBook
4720s
discrete

Supporis the following drives:
e 750-GB, 5400-rpm
e  640-GB, 5400-rpm
e 500-GB, 7200-rpm
e  320-GB, 7200-rpm

e  250-GB, 7200-rpm

\/

\/

Supports 9.5-mm, 6.35-cm (2.50-in) hard
drives

e 750-GB, 5400-rpm

HP 3D DriveGuard (not available on Linux)

Optical drives

Fixed, no modular requirements

SATA 12.7-mm tray load

Supporis option of no optical drive

Supporis the following drives:
e  DVD-ROM Drive

e  DVD+RW SuperMulti Double-Layer
Combo Drive with Lightscribe

e Bluray ROM DVD+RW SuperMulti DL
Drive (not available with UMA base unit
and Windows XP)

< | 2| 2| 2| 2| =2

2| 2| 2| 2| 2| =

R e e =

Diskette drive

Supports external USB diskette drive only

Audio/visual

IDT 92HD80

Integrated microphone

Stereo speakers (2)

Integrated 2MP camera with fixed focus
(select models only)

< | 2| 2| 2| <=

2| 2| 2| 2| <

2 | 2| 2| =2 | <

Modem

High-speed 56K modem for all regions and
countries except APJ

<2

<

High-speed 56K modem APJ only

Modem cable not included

Supports no modem option

Ethernet

10/100/1000 Ethernet network interface
card (NIC)

< | 2| <2 | <

< | 2| <2 | <

2 | <2 | 2| =

$3/54/S5 wake on LAN: AC only mode
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Category Description HP ProBook HP ProBook  HP ProBook

4520s UMA  4520s 4720s
discrete discrete
Wireless Integrated WLAN options by way of MiniPCl card:
2 WILAN antennas built into display assembly y y
Supports option for no-WLAN J y y
Support for the following WLAN formats: \/ y y

®  Broadcom 802.11b/g

e  Broadcom 802.11b/g/n

e  Broadcom 802.11a/b/g/n

e Atheros 802.11 b/g/n (1 x 1)

e  Ralink 802.11 b/g/n with Bluetooth
®  Realtek 802.11 b/g/n (1 x 1)

e Intel 802.11 b/g 1S/2R Russia only
e Intel 802.11 b/g/n 1S/2R

e Intel 802.11 a/b/g 1S/2R

e Intel 802.11 a/b/g/n 25/2R

Integrated personal area network (PAN) options by way of Bluetooth® module:

Support option for no-WPAN J y \

Bluetooth 2.1 RN N v

Integrated WWAN options by way of HP Mobile Broadband Module:

Supports only HP certified WWAN options J y

WWAN module UNDP Gobi2 including GPS
with 2 antennas (not available with Linux or

Celeron)
Dual WWAN antennas (world wide 5 band) ~ + N
SIM module (user accessible behind battery) N
External media One ExpressCard/34 mm \/ \/ 3
cards
Media Card Reader supporting Memory Stick y y
(MS), Memory Stick Pro (MSP), Secure Digital
(SD) Memory Card, Secure Digital High
Capacity (SDHC) Memory Card,
MultiMediaCard (MMC), and xD-Picture Card
formats
Ports Audio-in (stereo microphone) \ N v

Audio-out (stereo headphone) R v v




Category Description HP ProBook HP ProBook  HP ProBook
4520s UMA  4520s 4720s
discrete discrete
RJ-11 (modem) 3 \/ J
RJ-45 (Ethernet, includes link and activity y J J
lights)
USB 2.0 (3) J J N
Combination eSATA/USB 2.0 (1) N S \/
VGA (Dsub 15-pin) supporting 1600 x 1200 \/ J
external resolution at 75-GHz (hot plug/
unplug with auto-detect)
Multi-pin AC power y \/ J
HDMI v R J
Keyboard/ 15.6-in keyboard with integrated number pad J
pointing devices and Clickpad
17.3-in keyboard with integrated number pad J
and Clickpad
Suports 2-way scroll with legend and gestures J J
(taps enabled as default)
Power 65-W AC adapter with localized cable plug ¥
requirements support (3-wire plug with ground pin)
90-W AC adapter with localized cable plug N J
support (3-wire plug with ground pin)
8-cell, 73-Wh Li-ion battery N
Security Supports Kensington security lock y J J
Fingerprint reader 15.6-in Integrated fingerprint reader \/ V
17.3-in Integrated fingerprint reader V
Supports no fingerprint reader option V J J
Operating system  Preinstalled with Microsoft Office: y J J
Windows 7 Home Premium 32 with Office \/ \/ J
2007 Ready (excludes Japan)
Windows 7 Home Premium 32 with Office \/ \/ J
2007 Personal (Japan only)
Windows 7 Home Premium 32 with Office \/ N J
2007 Personal with PowerPoint (Japan only)
Windows 7 Home Premium 32 with Office V \/ J
2007 Professional (Japan only)
Windows 7 Professional with Office 2007 V \/ J

Ready (excludes Japan)
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Category Description HP ProBook HP ProBook  HP ProBook
4520s UMA 4520s 4720s
discrete discrete
Windows 7 Professional with Office 2007 R N v
Personal (Japan only)
Windows 7 Professional with Office 2007 RN N v
Personal with PowerPoint (Japan only)
Windows 7 Professional with Office 2007 S N v
Professional (Japan only)
Windows Vista Home Basic 32 with Office S N v
2007 Ready (lapan only)
Windows Vista Home Basic 32 with Office S N v
2007 Personal (Japan only)
Windows Vista Home Basic 32 with Office \ N v
2007 Professional (Japan only)
Windows Vista Business 32 with Office 2007 N v
Personal (Japan only)
Windows Vista Business 32 with Office \ N v
Personal with PowerPoint (Japan only)
Windows Vista Business 32 with Office RN N v
Professional (Japan only)
Windows 7 Starter with Office 2007 ready \/ \/ \/
(excludes Japan)
Windows 7 Starter 32 with Office 2007 RN N v
ready — EDGI
Windows 7 Home Basic 32 with Office 2007 N v
ready (excludes Japan)
Windows 7 Home Basic with Office 2007 RN N v
ready — EDGI
Windows 7 Home Premium with Office 2007 N v
ready — EDGI
Windows 7 Professional 32 with Office 2007 N v
ready — EDGI
Windows 7 Professional 32 with XP Pro S N v
images with Office 2007 ready (excludes
Japan)
Windows 7 Professional 32 with XP Pro S N v
images with Office 2007 ready — EDGI
Windows 7 Professional 32 with XP Pro S N v
images with Office 2007 Personal (Japan
only)
Windows 7 Professional 32 with XP Pro \/ N v

images with Office 2007 Personal with
PowerPoint (Japan only)




Category Description HP ProBook HP ProBook  HP ProBook

4520s UMA  4520s 4720s
discrete discrete

Preinstalled:
Windows 7 Professional 32 (Japan only) \/ J J
Windows 7 Home Premium 32 (Japan only) J J
Windows Vista Home Basic 32 with MS \/ \/ J
Basics (Japan only)
Windows Vista Business 32 with MS Basics 3 \/ J
(Japan only)
Windows 7 32 (with XP Professional images) v \/ J
with MS Basics (Japan only)
FreeDOS \/ N J
RedFlag Linux (People's Republic of China y J J
only)
SuSE Linux y J J
Restore media:
Windows 7 Home Basic 32 \/ 3 J
Windows 7 Home Premium 32 3 J J
Windows Vista Business 64 y J J
Windows 7 Professional 32 \/ \/ J
Windows 7 Professional 64 3 \/ J
DRDVD Windows 7 — Home Premium/Pro v v v
DRDVD Windows 7 — Starter/Home Basic N N v
Windows Vista Home Basic 32 \/ \/ J
Windows Vista Home Premium \/ N J
Windows Vista Business 32 3 J J
Windows XP Professional y J J
SuSE Linux \/ \/ J
Red Flag Linux (People's Republic of China \/ \/ J
only)
DRDVD Windows Vista \/ N J
DRDVD Windows XP Pro 3 J J
Certified: Microsoft® WHQL y J J
Web Support: V \/ J
Windows Vista business 3 J J
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Category

Description

HP ProBook
4520s UMA

HP ProBook
4520s
discrete

HP ProBook
4720s
discrete

Serviceability

End-user replaceable parts:

AC adapter

Battery (system)

Hard drive

Memory module

Optical drive

WILAN module

R R N I .

WWAN module

R e e e

P R I L B I




2 External component identification

EX NOTE: Depending on the operating system installed on your comouter, some components may
function differently than described. Some functionality may not be supported by the operating system
installed on your computer.

Top Components
TouchPad

3 4
Component Description
(1) TouchPad off indicator light To turn the TouchPad zone on and off, quickly doubletap the
TouchPad off indicator.
NOTE: When the TouchPad zone is active, the light is off.
(2) TouchPad zone* Moves the pointer and selects or activates items on the screen.
(3) Left TouchPad button Functions like the left button on an external mouse.
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Component

Description

4)

Right TouchPad button

Functions like the right button on an external mouse.

*This table describes factory seftings.

Lights

B NOTE: Your computer may look slightly different from the illustration in this section.

Component

Description

m

TouchPad off indicator

Amber: The TouchPad is off.

Off: The TouchPad is on.

(2) Caps lock light On: Caps lock is on.

(3) HP QuickLook light Blinking: QuickLook is being opened or closed.

(4) HP QuickWeb light Blinking: QuickWeb browser is being opened or closed.

(5) Power light e On: The computer is on.

e  Blinking: The computer is in the Sleep state.
e Off: The computer is off or in Hibernation.

(5) Wireless light e White: An integrated wireless device, such as a wireless
local area network (WLAN) device and/or a Bluetooth®
device, is on.

e Amber: All wireless devices are off.

Top Components
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Buttons, switches, and speakers (select models only)

B NOTE: Your computer may look slightly different from the illustration in this section.

Component

Description

(1) Speakers (2)

Produce sound.

(2) Internal display switch

Turns off the display if the display is closed while the power is on.

(3) Power button

®  When the computer is off, press the button to turn on the
computer.

e When the computer is on, press the button to shut down the
computer.

®  When the computer is in the Sleep state, press the button
briefly to exit Sleep.

e When the computer is in Hibernation, press the button briefly
to exit Hibernation.

If the computer has stopped responding and Windows shutdown
procedures are ineffective, press and hold the power button for at
least 5 seconds to turn off the computer.

(4) Fingerprint reader (select models only)

Allows a fingerprint logon to Windows, instead of a password
logon.
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Component Description

(1) esc key Displays system information when pressed in combination with the
fn key.

(2) fn key Executes frequently used system functions when pressed in

combination with a function key, the num lk key, or the esc key.

(3) Windows logo key Displays the Windows Start menu.

(4) Windows applications key Displays a shortcut menu for items beneath the pointer.
(5) Integrated numeric keypad keys Can be used like the keys on an external numeric keypad.
(6) Function keys Execute frequently used system functions when pressed in

combination with the fn key.

Top Components 13



Front components

Toe
® OO

Component

Description

(1) Drive light

Blinking white: The hard drive or optical drive is being
accessed.

Amber: HP 3D DriveGuard has temporarily parked the hard

drive.

(2) Media Card Reader

Supports the following optional digital card formats:

Memory Stick

Memory Stick Duo (adapter required)
Memory Stick Pro (adapter required)
MultiMediaCard (MMC)

Secure Digital (SD) Memory Card
xD-Picture Card (XD)

xD-Picture Card (XD) Type H

xD-Picture Card (XD) Type M

(3) Audio-out (headphone) jack

Produces sound when connected to optional powered stereo
speakers, headphones, ear buds, a headset, or television audio.

NOTE: When a device is connected to the headphone jack, the
computer speakers are disabled.

(4) Audio-in (microphone) jack

Connects an optional computer headset microphone, stereo array
microphone, or monaural microphone.

14 Chapter 2 External component identification



Right-side components

1 2
Q0 ©
Component Description
(1) USB ports (2) Connect optional USB devices.
(2) RJ-11 (modem) jack (select models only) Connects a modem cable.
(3) Optical drive (select models only) Reads optical discs and, on select models, also writes to optical
discs.
(4) Optical drive light (select models only) Blinking: The optical drive is being accessed.
(5) AC adapter light e  On: The computer is connected to external power and the

battery is charging.

e  Off: The computer is not connected to external power.

(6) Power connector Connects an AC adapter.

Left-side components

Component Description

(1) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a deterrent, but it
may not prevent the computer from being mishandled or stolen.

(2) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool internal
components and prevent overheating. It is normal for the internal
fan to cycle on and off during routine operation.

(3) External monitor port Connects an external VGA monitor or projector.

(4) RJ-45 (network) jack Connects a network cable.

Right-side components



Component

Description

(5) HDMI port

Connects an optional HDMI device.

(6) Combo eSATA/USB port

Connects an optional USB device or high-performance eSATA
components such as an eSATA external hard drive.

(7) USB port

Connects optional USB device.

(8) ExpressCard slot

Supports optional ExpressCards.

Bottom components

*

C)

Component

Description

(1) Battery release latches (2)

Release the battery from the battery bay.

(2) Battery bay

Holds the battery.

(3) SIM slot (select models only)

Contains a wireless subscriber identity module (SIM). The SIM slot
is located inside the battery bay.
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Display

B NOTE: Your computer may look slightly different from the illustration in this section.

®

9

Component Description

(1) Internal display switch Turns off the display if the display is closed while the power is on.
(2) Internal microphone Records sound.

(3) Webcam light (select models only) On: The webcam is in use.

(4) Webcam (select models only) Records audio and video and captures still photographs.

Display
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Wireless antennas

The antennas send and receive signals from one or more wireless devices. These antennas are not
visible from the outside of the computer.

Component Description

(1) WWAN antennas (2)* (select models only) Send and receive wireless signals to communicate with wireless
wide-area networks (WWAN).

2 WILAN antennas (2)* Send and receive wireless signals to communicate with wireless
9
local area networks (WLAN).

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around
the antennas free from obstructions.

To see wireless regulatory notices, refer to the section of Regulatory, Safety and Environmental Notices
that apply to your country or region. These notices are located in Help and Support.
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Additional hardware components

ﬂi

Component Description
(1) Power cord* Connects an AC adapter fo an AC outlet.
(2) Battery* Powers the computer when the computer is not plugged into

external power.

(3) AC adapter Converts AC power to DC power.

*Batteries and power cords vary in appearance by country or region.
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3 lllustrated parts catalog

Service tag

When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag.

(1) Product name: This is the product name affixed to the front of the computer.
(2) Serial number (s/n): This is an alphanumeric identifier that is unique to each product.

art number/product number (p/n): This number provides specific information about the product's
3) Part number/product number (p/n): Thi ber provides specific information about the product'
hardware components. The part number helps a service technician to determine what components and
parts are needed.

(4) Model description: This is the alphanumeric identifier used to locate documents, drivers, and
support for your computer.

(5) Warranty period: This number describes the duration of the warranty period for this computer.

n—pmdunl B0 KX
ﬂ—s.rn xaoococeees TN

e__lﬂl'l e (1 AU TR e VT AT

SEMVICE | XX0000
tag |warranty X year.

00
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Computer major components

ltem  Description

(1) Display assembly (includes microphone, 2 WLAN antenna transceivers and cables and, on select computer
models, 2 WWAN antenna transceivers and cables)

For use only with computers with 17.3-in displays
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Item  Description

e 17.3-in HD BrightView display assembly for use in computers equipped with webcam 598708-001
and WWAN (1600x900 resolution)

e 17.3-in HD BrightView display assembly (1600x900 resolution) 606167-001

e 17.3-in HD AntiGlare display assembly for use in computers equipped with webcam 606166-001
and WWAN (1600x900 resolution)

e 17.3-in HD AntiGlare display assembly (1600x900 resolution) 606165-001

e 17.3-in HD+ AntiGlare display assembly (1600x900 resolution) 599080-001

For use only with computers with 15.6-in displays and black trim

®  15.6-in HD BrightView display assembly for use in computers equipped with webcam 598707001
and WWAN (1366x768 resolution)

e 15.6-in HD BrightView display assembly for use in computers with webcam (1366x768  598706-001
resolution)

e 15.4-in HD BrightView display assembly (1366x768 resolution) 598705-001

e 15.6-in HD BrightView LVDS display assembly (1366x768 resolution) 623182001

e 15.6-in HD AntiGlare display assembly for use in computers equipped with webcam 598704-001
and WWAN (1366x768 resolution)

e  15.6-in HD AntiGlare display assembly for use in computers equipped with webcam 598703-001
(1366x768 resolution)

e 15.6-in HD AntiGlare display assembly (1366x768 resolution) 598702-001

e  15.6-in HD SVA LVDS AntiGlare display assembly (1366x768 resolution) 624238001

e  15.6-in WVA LVDS HD AntiGlare display assembly (1366x768 resolution) 624643-001

For use only with computers with 15.6-in displays and red trim

®  15.6-in HD BrightView display assembly for use in computers with webcam and 604859001
WWAN (1366x768 resolution)

®  15.6-in HD BrightView display assembly for use in computers with a webcam 604858-001
(1366x768 resolution)

e 15.4-in HD BrightView display assembly for use in computers (1366x768 resolution) 604857-001

®  15.6-in HD AntiGlare display assembly for use in computers equipped with webcam 604856-001
and WWAN (1366768 resolution)

e 15.6-in HD AntiGlare display assembly for use in computers equipped with a webcam 604855-001
(1366x768 resolution)

e 15.6-in HD AntiGlare display assembly (1366x768 resolution) 604854-001

For use only with computers with 15.6-in displays and champagne trim

e  15.6-in HD BrightView display assembly for use in computers with webcam and 626120001
WWAN (1366x768 resolution)

e  15.6-in HD BrightView display assembly for use in computers with a webcam 626119001
(1366x768 resolution)

e  15.6-in HD BrightView display assembly (1366x768 resolution) 626118001

22  Chapter 3 lllustrated parts catalog



Item  Description
e 15.6-in HD AntiGlare display assembly for use in computers equipped with a webcam 626117001
and WWAN (1366x768 resolution)
e  15.6-in HD AntiGlare display assembly for use in computers equipped with a webcam 626116-001
(1366x768 resolution)
e  15.6-in HD AntiGlare display assembly (1366x768 resolution) 626115001
(2) Switch cover
For use in computers with 17.3-in displays 598675001
For use in computers with 15.6-in displays and red trim 604853-001
For use in computers with 15.6-in displays and black or red trim 598674-001
For use in computers with 15.6-in displays and champagne-colored trim 626114001
(3) Keyboard
NOTE: For a detailed list of available keyboards, see Sequential part number listing on page 38.
For use in computers with 17.3-in displays 598692-xxx
For use in computers with 15.6-in displays 59869 1-xxx
(4) Palm rest (includes TouchPad and cables)
For use in computers with 17.3-in displays 598689001
For use in computers with 15.6-in displays 598688-001
For use in computers with 15.6-in displays and red trim 604852-001
For use in computers with 17.3-in displays with fingerprint reader 599805-001
For use in computers with 15.6-in displays with fingerprint reader and with black trim 599804-001
For use in computers with 15.6-in displays with fingerprint reader and with red trim 604861-001
For use in computers with 15.6-in displays with fingerprint reader and with champagne- 626113001
colored trim
(5) Thermal shield 603700-001
(6) Power button board 609952-001
(7) ExpressCard bezel (part of Plastics Kit spare part number 598673-001)
(8) Speakers
For use in computers with 17.3-in displays 598686-001
For use in computers with 15.6-in displays 598685-001
(9) Top cover
For use in computers with 17.3-in displays 598683001
For use in computers with 15.6-in displays 598682-001
(10) Audio board 598684-001

Computer major components
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Item  Description
(11) Bluetooth module 537921-001
HP Integrated module with Bluetooth 2.1 wireless technology for use in Andorra,
Argentina, Australia, Austria, Bangladesh, Belarus, Belgium, Bermuda, Brazil, Brunei,
Bulgaria, Canada, Cayman Islands, Chile, China, Croatia, Cyprus, Czech Republic,
Denmark, Egypt, El Salvador, Estonia, Finland, France, Germany, Greece, French Guiana,
Guadeloupe, Guam, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, ltaly,
Japan, Jordan, South Korea, Latvia, Puerto Rico, Liechtenstein, Lithuania, Luxembourg,
Malaysia, Malta, Martinique, Mexico, Morocco, Netherlands, New Zealand, Norway,
Pakistan, Panama, Peru, Philippines, Poland, Portugal, Romania, Russia, Saudi Arabia,
Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Taiwan,
Thailand, Tunisia, Turkey, Ukraine, United Arab Emirates, the United Kingdom, the United
States, Venezuela, and the Virgin Islands
(12) Fan/heat sink assembly
For use in computers with discrete graphics subsystems 598677-001
For use in computers with UMA graphics subsystems 607132-001
(13)  System board (includes RTC battery and replacement thermal material)
System board with discrete graphics subsystem memory 598668-001
System board with UMA graphics subsystem memory 598667001
System board with discrete graphics, WWAN capability, and RTC battery for use in 4720s ~ 598670-001
models
System board with UMA graphics subsystem memory and WWAN 598669-001
System board with discrefe graphics subsystem memory for use only in the People's Republic ~ 605169-001
of China and Russia
System board with UMA graphics subsystem memory for use only in the People's Republic of ~ 605168-001
China and Russia
System board with UMA graphics subsystem memory and WWAN for use only in the 605170001
People's Republic of China and Russia
System board with discrete graphics, WWAN capability, and RTC battery for use only in the ~ 605171-001
People's Republic of China and Russia
System board with ATl Mobility Radeon HD 5470 graphics for use in 4720s models 628794001
System board with ATl Mobility Radeon HD 5470 graphics for use in 4520s models 628795001
(14) Power connector (part of Base Cable Kit 603188-001 for computers with 17.3-in displays
and Base Cable Kit 599807-001 for computers with 15.6-in displays)
(15) RJ-11 connector (part of Base Cable Kit 603188-001 for computers with 17.3-in displays
and Base Cable Kit 599807-001 for computers with 15.6-in displays)
(16)  USB connector (part of Base Cable Kit 603188-001 for computers with 17.3-in displays
and Base Cable Kit 599807-001 for computers with 15.6-in displays)
(17)  WLAN module
Intel Centrino Advanced-N6200 802.11 a/b/g 2x2 for use only in Russia and 572510-001

Ukraine
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Item

Description

Intel Centrino Advanced-N6200 802.11 a/b/g/n 2x2 for use in Andorra, Antigua ~ 572509-001
& Barbuda, Argentina, Australia, Austria, Azerbaijan, Bahamas, Bahrain, Barbados,
Belgium, Bolivia, Bosnia & Herzegovina, Brazil, Brunei, Bulgaria, Canada, Chile, Ching,
Colombia, Costa Rica, Croatia, Cyprus, Czech Republic, Denmark, Dominican Republic,
Ecuador, Egypt, El Salvador, Estonia, Finland, France, Georgia, Germany, Ghana, Greece,
Guam, Guatemala, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia,
Ireland, Israel, ltaly, Ivory Coast, Jamaica. Japan, Jordan, Kenya, South Korea, Kuwait,
Kyrgyzstan, Latvia, Lebanon, Martinique, Nether Antilles, Puerto Rico, French Guiana,
Guadeloupe, Cayman Islands, Bermuda, Aruba, Liechtenstein, Lithuania, Luxembourg,
Malawi, Malaysia, Malta, Mauritius, Mexico, Monaco, Montenegro, Morocco, Netherlands,
New Zealand, Nicaragua, Nigeria, Norway, Oman, Pakistan, Panama, Paraguay, Peru,
Philippines, Poland, Portugal, Qatar, Romania, San Marino, Saudi Arabia, Senegal,
Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Taiwan,
Tanzania, Thailand, Trinidad & Tobago, Tunisia, Turkey, United Arab Emirates, the United
Kingdom, the United States, Uruguay, Venezuela, Vietnam, Virgin Islands

Intel Centrino Wireless-N1000 802.11 b/g 1x2 for use in Andorra, Antigua & 585984-001
Barbuda, Argentina, Aruba, Australia, Austria, Azerbaijan, Bahamas, Bahrain, Barbados,
Belgium, Bermuda, Bolivia, Bosnia & Herzegovina, Brazil, Brunei, Bulgaria, Canada,
Cayman Islands, Chile, China, Colombia, Costa Rica, Croatia, Cyprus, Czech Republic,
Denmark, Dominican Republic, Ecuador, Egypt, El Salvador, Estonia, Finland, France, French
Guiana, Georgia, Germany, Ghana, Greece, Guadeloupe. Guatemala, Haiti, Honduras,
Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, ltaly, Ivory Coast, Jamaica,
Japan, Jordan, Kenya, South Korea, Kuwait, Kyrgyzstan, Latvia, Lebanon, Nether Antilles,
Martinique, Puerto Rico, Guam, Liechtenstein, Lithuania, Luxembourg, Malawi, Malaysia,
Malta, Mauritius, Mexico, Monaco, Montenegro, Netherlands, New Zealand, Nicaragua,
Nigeria, Norway, Oman, Pakistan, Panama, Paraguay, Peru, Philippines, Poland, Portugal, ,
Romania, San Marino, Saudi Arabia, Senegal, Singapore, Slovakia, Slovenia, South Africa,
Spain, Sri Lanka, Sweden, Switzerland, Taiwan, Tanzania, Thailand, Trinidad & Tobago,
Turkey, Ukraine, United Arab Emirates, the United Kingdom, the United States, Uruguay,
Venezuela, Vietnam, Virgin Islands

Broadcom 4312G 802.11b/g WiFi adapters:

e For use in Antigua and Barbuda, Barbados, Belize, Canada, the Cayman Islands, 504593-003
Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United States

Computer major components
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Item  Description

e  For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, 504593-004
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad,
Chile, the People's Republic of China, Colombia, Comoros, the Congo, Costa Rica,
Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican
Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia,
Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany,
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissav,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, ltaly, the
Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia,
Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the
Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan,
Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal,
the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome
and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore,
Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri
Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname,
Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad
and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab
Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam,
Yemen, Zaire, Zambia, and Zimbabwe

Intel Wi-Fi Link 1000, 802.11b/g/n WLAN module for use in Andorra, Antigua and  572520-001
Barbuda, Argentina, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Barbados,
Belgium, Bolivia, Bosnia and Herzegovina, Brazil, Brunei, Bulgaria, Canada, Cayman
Islands, Chile, China, Colombia, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark,
the Dominican Republic, Ecuador, Egypt, El Salvador, Estonia, Finland, France, French
Guiana, Guadeloupe, Guam, Georgia, Germany, Ghana, Greece, Guatemala, Haiti,
Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, ltaly, Ivory Coast,
Jamaica, Japan, Jordan, Kenya, Kuwait, Kyrgyzstan, Latvia, Lebanon, Liechtenstein, Lithuania,
Luxembourg, Malawi, Malaysia, Malta, Martinique, Mauritius, Mexico, Monaco,
Montenegro, Morocco, the Nether Antilles, the Netherlands, New Zealand, Nicaragua,
Nigeria, Nigeria, Oman, Pakistan, Panama, Paraguay, Peru, the Philippines, Poland,
Portugal, Puerto Rico, Quatar, Romania, San Marino, Saudi Arabia, Senegal, Singapore,
Slovakia, Slovenia, South Africa, South Korea, Spain, Sri Lanka, Sweden, Switzerland,
Taiwan, Tanzania, Thailand, Trinidad and Tobago, Turkey, United Arab Emirates, the United
Kingdom, the United States, Uruguay, the U.S. Virgin Islands, Venezuela, and Vietnam

Atheros 9285G 802.11b/g/n WiFi Adapter for use in all countries and regions 605560-005

Realtek RTL8191SE 802.11b/g/n WiFi Adapter for use in all countries and regions ~ 593533-001

Broadcom 4322 AGN, 802.11a/b/g/n

e  For use in Antigua and Barbuda, Barbados, Belize, Canada, the Cayman Islands, 518434-001
Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United States
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Item  Description

e  For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad,
Chile, the People's Republic of China, Colombia, Comoros, the Congo, Costa Rica,
Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican
Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia,
Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany,
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-
Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel,
Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos,
Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia,
Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the
Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan,
Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal,
the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome
and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore,
Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri
Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname,
Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad
and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab
Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam,
Yemen, Zaire, Zambia, and Zimbabwe

518434-002

Broadcom 4313AGN 802.11a/b/g/draft-n WiFi Adapter for use in Afghanistan,
Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba,
Australia, Austria, Azerbaijan, Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium,
Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the
British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon,
Canada, Cape Verde, the Cayman Islands, Central African Republic, Chad, People's
Republic of China, Colombia, Comoros, Congo, Costa Rica, Croatia, Cyprus, the Czech
Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt,
El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French
Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada,
Guadeloupe, Guam, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras, Hong
Kong, Hungary, Iceland, India, Iraq, Ireland, Israel, ltaly, Ivory Coast, Jamaica, Japan,
Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho,
Liberia, Martinique, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi,
Malaysia, Maldives, Mali, Malta, Marshall Islands, Mauritania, Mauritius, Mexico,
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru,
Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria,
Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Puertfo Rico, Peru,
Philippines, Poland, Portugal, Qatar, Republic of Moldova, Romania, Russia, Rwanda,
Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia and
Montenegro, Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, Solomon Islands,
Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St.
Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Syria, Taiwan,
Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey,
Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom,
Uruguay, the United States, the US Virgin Islands, Uzbekistan, Vanuatu, Venezuela, Vietnam,
Yemen, Zaire, Zambia, and Zimbabwe

593836-001
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Item  Description

Broadcom 4313 802.11b/g/n 1x1 WiFi and 2070 Bluetooth 2.1+EDR Combo 600370001

Adapter for use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, Bahamas, Bahrain, Bangladesh,
Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and
Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso,
Burundi, Cambodia, Cameroon, Canada, Cape Verde, the Cayman Islands, Central African
Republic, Chad, Chile, the People's Republic of China, Colombia, Comoros, Congo, Costa
Rica, Croatia, Cyprus, Czech Republic, Denmark, Djibouti, Dominica, the Dominican
Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia,
Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana,
Gibraltar, Greece, Grenada, Guadeloupe, Guam, Guatemala, Guinea, Guinea-Bissa,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Iraq, Ireland,
Israel, ltaly, Ivory Coast, Jamaica, Japan, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait,
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagascar, Malawi, Malaysia, Maldives, Mali, Malta, Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New
Guinea, Paraguay, Peru, Philippines, Poland, Portugal, Puerto Rico, Qatar, the Republic of
Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi
Arabia, Senegal, Serbia and Montenegro, Seychelles, Sierra leone, Singapore, Slovakia,
Slovenia, Solomon Islands, Somalia, South Africa, South Korea, Sri Lanka, St. Kitts and
Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden,
Switzerland, Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad and Tobago,
Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United
Kingdom, the United States, Uruguay, the US Virgin Islands, Uzbekistan, Vanuatu, Venezuela,
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

Ralink RT3090BC4 802.11b/g/n 1x1 WiFi and Bluetooth 2.1+EDR Combo 602992-001
Adapter for use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, Bahamas, Bahrain, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina,
Botswana, Brazil, British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia,
Cameroon, Canada, Cape Verde, the Cayman Islands, Central African Republic, Chad,
Chile, the People's Republic of China, Colombia, Comoros, Congo, Costa Rica, Croatia,
Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East
Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland,
France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece,
Grenada, Guadeloupe, Guam, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras,
Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, Ivory Coast, Jamaica,
Japan, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, laos, Latvia, Lebanon,
Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi,
Malaysia, Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius,
Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia,
Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger,
Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the
Philippines, Poland, Portugal, Puerto Rico, the Republic of Moldova, Romania, Russia,
Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia and
Montenegro, Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands,
Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St.
Vincent and Grenadines, Suriname, Swaziland, Sweden, Switzerland, Syria, Taiwan,
Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey,
Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom,
Uruguay, the US Virgin Islands, the United States, Uzbekistan, Vanuatu, Venezuela, Vietnam,
Yemen, Zaire, Zambia, and Zimbabwe

(18)  Processor (includes replacement thermal material)

Intel Core processors:

i3-330M, 2.13-GHz, 3-MB cache 597622-001

i3-350M, 2.26-GHz, 3-MB cache 597623-001
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Item  Description

i3-370M, 2.40-GHz, 3-MB cache 613584-001

i3-380M, 2.53-GHz, 3-MB cache 625823-001

i5-430M, 2.26-GHz, 3-MB cache 597624-001

i5-450M, 2.40-GHz, 3-MB cache 613585-001

i5-460M, 2.53-GHz, 3-MB cache 626039-001

i5-520M, 2.4-GHz, 3-MB cache 594187-001

i5-540M, 2.53-GHz, 3-MB cache 594188-001

i7-620M, 2.26-GHz, 4-MB cache 587259-001

Intel Pentium processors:

P6000, 1.86-GHz, 3-MB cache 613586-001

P6100, 2.00-GHz, 3-MB cache 613587-001

P6200, 2.13-GHz, 3-MB cache 625831-001

Intel Celeron processor:

P4500, 1.86-GHz, 2-MB cache 611699001
(19)  RTC battery 616073-001
(20) HP un2420 Broadband Module 531993-001
(21)  Optical drive extender for use only in computers with 17.3-in displays 598687001
(22) Modem module

NOTE: The modem module spare part kit does not include a modem module cable. The

modem module cable is included in the Base Cable Kit , spare part numbers 599807-001.

See Cable Kits on page 33 for more Cable Kit spare part information.

For use in all countries and regions except Australia and New Zealand 510100001

For use only in Australia and New Zealand 510100011
(23) Memory module

4-GB (PC3-10600, 1333-MHz, DDR3) 599092-001

2-GB (PC3-10600, 1333-MHz, DDR3) 598856-001

1-GB (PC3-10600, 1333-MHz, DDR3) 598859-001
(24) Battery

8-cell, 73-Wh, 2.55-Ah for use in computers with 17.3-in displays 593576-001

9-cell, 93-Wh, 2.8-Ah for use in computers with 15.6-in displays 593573-001

6-cell, 47-Wh, 2.2 Ah for use in computers with 15.6-in displays 593572-001
(25) Base enclosure

For use in computers with 17.3-in displays 598681-001

Computer major components
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Item  Description

For use in computers with 15.6-in displays 598680-001
(26) Hard drive (includes hard drive bracket)
750-GB, 5400-rpm 598699-001
640-GB, 5400-rpm 617667-001
500-GB, 7200-rpm 598698-001
320-GB, 7200-rpm 598697-001
250-GB, 7200-rpm 598696-001
(27) Optical drive (includes bezel)
DVD-ROM Dirive 598693-001
DVD+RW Double-Layer Drive with LightScribe 598694-001
Blu-ray Disc ROM Drive with SuperMulti DVD+R/RW Double-Layer 598695-001
Rubber Kit (not illustrated, contains: 10 front rubber feet, 10 rear rubber feet, 10 back 598678-001

edge screw covers, and 10 mylar screw covers for LCD bezel)
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Display assembly components
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Item Description Spare part number
(1) Display bezel
For use in computers with 17.3-in displays without webcam 600924-001
For use in computers with 15.6-in displays without webcam 598690001
For use in computers with 17.3-in displays with webcam 600927-001
For use in computers with 15.6-in displays with webcam 600926-001
(2) Webcam module 598671-001
(3) Display (For Reference only. Not spared separately.)

Display assembly components
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ltem Description Spare part number
(4) Display Hinge Kit
For use in computers with 17.3-in displays 602677001
For use in computers with 15.6-in displays 598679-001
(5) Microphone cable
(6) LCD Cable Kit with webcam cable
For use in computers with 17.3-in displays 602999001
For use in computers with 15.6-in displays 600925-001
(7) WLAN and WWAN antenna transceivers and cables
(8) Display enclosure
For use in computers with 17.3-in displays 600929-001
For use in computers with 15.6-in displays and black trim 600928-001
For use in computers with 15.6-in displays and red trim 607133-001

Plastics Kit

0—\

Item

Description

Spare part number

Plastics Kit:

598673-001

m

ExpressCard slot bezel

(2)

Optical drive bezel

RJ-11 Dummy door (not illustrated)
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Cable Kits

Item Description Spare part number

Base Cable Kit

For use in computers with 17.3-in displays, includes DC-in cable (1), USB cable (2), 603188-001
Bluetooth cable (3), and RJ-11 cable (4).

For use in computers with 15.6-in displays, includes DC-in cable (1), USB cable (2), 599807-001
Bluetooth cable (3), and RJ-11 cable (4).

(1) DC:in cable, lengths differ for 17.3-in and 15.6-in computers

(2) USB cable, lengths differ for 17.3-in and 15.6-in computers

(3) Bluetooth cable, lengths differ for 17.3-in and 15.6-in computers

(4) RJ-11 cable, common to both 17.3-in and 15.6-in computers
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Item Description

Spare part number

Misc LCD Cable Kit

For use in computers with 15.6-in displays, includes microphone cable (1), WWAN 599806-001
transceiver with cable (2), and WLAN transceiver with cable (3)

For use in computers with 17.3-in displays, includes items (1), (2), and (3) 606974001
Display cable, HD+ 629030001

(1) Microphone cable, lengths differ for 17.3-in and 15.6-in computers

(2) WWAN transceiver with cable, lengths differ for 17.3-in and 15.6-in computers

(3) WILAN transceiver with cable, lengths differ for 17.3-in and 15.6-in computers
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ltem Description Spare part number
(1) LCD Cable Kit with webcam cable

For use in computers with 17.3-in displays 602999001

For use in computers with 15.6-in displays 600925-001

LCD Cable without webcam cable

For use in computers with 17.3-in displays 606973-001

For use in computers with 15.6-in displays 606972001

Mass storage devices

o—

Item Description Spare part number
(1) Hard drive (includes bracket)

750-GB, 5400-rpm 598699001

640-GB, 5400-rpm 617667001

500-GB, 7200-rpm 598698-001

320-GB, 7200-rpm 598697-001

250-GB, 7200-rpm 598696-001
(2) Optical drive (includes bezel)

DVD+RW Double-Layer Drive with LightScribe 598694-001

Mass storage devices
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Item Description Spare part number

DVD-ROM Drive 598693-001

Blu-ray Disc ROM Drive with SuperMulti DVD+R/RW Double-Layer 598695001

Miscellaneous parts

Description Spare part number

AC adapters

65-W Smart AC adapter with power factor correction (PFC), RC/V EM 3W for use in the Asia- 609948-001 or
Pacific region 613161-001
65-W AC adapter for use in computers with UMA graphics 613152-001
90-W Slimline PFC AC adapter for use in computers with discrete graphics 613153-001

Power cords

For use in Argentina 490371-D0O1
For use in Australia and New Zealand 490371011
For use in Brazil 490371-201
For use in Denmark 490371-081
For use in Europe, the Middle East, and Africa 490371-021
For use in India 490371-D61
For use in Israel 490371-BB1
For use in Italy 490371-061
For use in Japan 490371-291
For use in the People's Republic of China 490371-AA1
For use in South Africa 490371-AR1
For use in South Korea 490371-AD1
For use in Switzerland 490371-111
For use in Taiwan 490371-AB1
For use in the United Kingdom 490371031
For use in the United States 490371-001
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Description Spare part number

Screw Kit, includes: 598672-001
e (5) Phillips 2.0x2.0 screws

e (5) Phillips 2.0x2.5 broadhead screws

e (5) Phillips 2.0x2.5 screws

e (5) Phillips 2x7.0 screws

e (5) Phillips 2.5%3.0 screws

e (5) Phillips 2.5x5.0 screws

e (5) Torx 2.5%5.0 screws

e (5) Torx 2.5x6.0 screws

e (5) Phillips 2.5x8.0 screws

e (10) Phillips 3.0x4.0 screws

Rubber Kit (contains: 10 front and 10 rear rubber feet, 10 back edge screw covers and 10 mylar  598678-001
screw covers for LCD bezel)
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Sequential part number listing

Spare part  Description
number

490371-001  Power cord for use in the United States

490371011 Power cord for use in Australia and New Zealand

490371-021  Power cord for use in Europe, the Middle East, and Africa

490371-031  Power cord for use in the United Kingdom

490371-061  Power cord for use in ltaly

490371-081  Power cord for use in Denmark

490371-111  Power cord for use in Switzerland

490371201 Power cord for use in Brazil

490371-291  Power cord for use in Japan

490371-AA1  Power cord for use in the People's Republic of China

490371-AB1  Power cord for use in Taiwan

490371-AD1  Power cord for use in South Korea

490371-AR1T  Power cord for use in South Africa

490371-BB1  Power cord for use in Israel

490371-DO1  Power cord for use in Argentina

490371-D61  Power cord for use in India

504593-003  Broadcom BCM4312 802.11b/g WLAN module for use in Antigua and Barbuda, Barbados, Belize,
Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the
United States

504593-004 Broadcom 4312 802.11b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola,
Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina,
Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde,
the Central African Republic, Chad, Chile, the People's Republic of China, Colombia, Comoros, the Congo,
Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East
Timor, Ecuador, Egypt, El Salvador, Equitorial Guineaq, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French
Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe,
Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland,
Israel, ltaly, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon,
Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the
Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia,
Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the
Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua
New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania, Russia,
Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra
Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri
Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden,
Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan,
Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu,
Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe
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Spare part
number

Description

510100-001

Modem module for use in all countries and regions except Australia and New Zealand

510100-011

Modem module for use in Australia and New Zealand

518434-001

Broadcom 4322 AGN 802.11a/b/g/n WLAN module for use in Antigua and Barbuda, Barbados, Belize,
Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the
United States

518434-002

Broadcom 4322 AGN 802.11a/b/g/n WLAN module for use in Afghanistan, Albania, Algeria, Andorra,
Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas,
Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and
Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon,
Cape Verde, the Central African Republic, Chad, Chile, the People's Republic of China, Colombia, Comoros,
the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican
Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland,
France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada,
Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland,
India, Ireland, Israel, ltaly, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos,
Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, luxembourg, Macedonia, Madagascar, Malawi,
Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico,
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether
Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau,
Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova,
Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the
Seychelles, Sierra leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South
Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland,
Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey,
Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan,
Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

531993-001

HP un2420 Broadband Module

537921-001

Bluetooth module with Bluetooth 2.1 wireless technology

572509-001

Intel Centrino Advanced-N6200 802.11a/b/g/n 2x2 WLAN for use in Andorra, Antigua and Barbuda,
Argentina, Aruba, Australia, Austria, Azerbaijan, Bahamas, Bahrain, Barbados, Belgium, Bermuda, Bolivia,
Bosnia and Herzegovina, Brazil, Brunei, Bulgaria, Canada, Cayman Islands, Chile, the People's Republic of
China, Colombia, Costa Rica, Croatia, Cyprus, Czech Republic, Denmark, Dominican Republic, Ecuador,
Egypt, El Salvador, Estonia, Finland, France, French Guiana, Georgia, Germany, Ghana, Greece,
Guadeloupe, Guam, Guatemala, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland,
Israel, ltaly, Ivory Coast, Jamaica, Japan, Jordan, Kenya, Kuwait, Kyrgyzstan, Latvia, Lebanon, Martinique,
Liechtenstein, Lithuania, Luxembourg, Malawi, Malaysia, Malta, Mauritius, Mexico, Monaco, Montenegro,
Morocco, the Nether Antilles, Netherlands, New Zealand, Nicaragua, Nigeria, Norway, Oman, Pakistan,
Panama, Paraguay, Peru, Philippines, Poland, Portugal, Puerto Rico, Qatar, Romania, San Marino, Saudi
Arabia, Senegal, Singapore, Slovakia, Slovenia, South Africa, South Korea, Spain, Sri Lanka, Sweden,
Switzerland, Taiwan, Tanzania, Thailand, Trinidad and Tobago, Tunisia, Turkey, the United Arab Emirates,
the United Kingdom, the United States, Uruguay, the U.S. Virgin Islands, Venezuela, Vietnam

572510-001

Intel Centrino Advanced-N6200 802.11a/b/g 2x2 WLAN for use in Russia, and Ukraine

Sequential part number listing
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Spare part
number

Description

572520-001

Intel Wi-Fi Link 1000, 802.11b/g/n WLAN module for use in Andorra, Antigua and Barbuda, Argenting,
Aruba, Australia, Austria, Azerbaijan, the Bahamas, Barbados, Belgium, Bolivia, Bosnia and Herzegovina,
Brazil, Brunei, Bulgaria, Canada, Cayman Islands, Chile, China, Colombia, Costa Rica, Croatia, Cyprus, the
Czech Republic, Denmark, the Dominican Republic, Ecuador, Egypt, El Salvador, Estonia, Finland, France,
French Guiana, Guadeloupe, Guam, Georgia, Germany, Ghana, Greece, Guatemala, Haiti, Honduras,
Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, ltaly, Ivory Coast, Jamaica, Japan, Jordan,
Kenya, Kuwait, Kyrgyzstan, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malawi, Malaysia, Malta,
Martinique, Mauritius, Mexico, Monaco, Montenegro, Morocco, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Nigeria, Nigeria, Oman, Pakistan, Panama, Paraguay, Peru, the Philippines, Poland,
Portugal, Puerto Rico, Quatar, Romania, San Marino, Saudi Arabia, Senegal, Singapore, Slovakia, Slovenia,
South Africa, South Korea, Spain, Sri Lanka, Sweden, Switzerland, Taiwan, Tanzania, Thailand, Trinidad and
Tobago, Turkey, United Arab Emirates, the United Kingdom, the United States, Uruguay, the U.S. Virgin
Islands, Venezuela, and Vietnam

585984-001

Intel Centrino WirelesssN1000 802.11 b/g 1x2 WLAN for use in Andorra, Antigua & Barbuda, Argentina,
Aruba, Australia, Austria, Azerbaijan, Bahamas, Bahrain, Barbados, Belgium, Bermuda, Bolivia, Bosnia &
Herzegovina, Brazil, Brunei, Bulgaria, Canada, Cayman Islands, Chile, China, Colombia, Costa Rica,
Croatia, Cyprus, Czech Republic, Denmark, Dominican Republic, Ecuador, Egypt, El Salvador, Estonia,
Finland, France, French Guiana, Georgia, Germany, Ghana, Greece, Guadeloupe. Guatemala, Haiti,
Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, Ivory Coast, Jamaica, Japan,
Jordan, Kenya, South Korea, Kuwait, Kyrgyzstan, Latvia, Lebanon, Nether Antilles, Martinique, Puerto Rico,
Guam, Liechtenstein, Lithuania, Luxembourg, Malawi, Malaysia, Malta, Mauritius, Mexico, Monaco,
Montenegro, Netherlands, New Zealand, Nicaragua, Nigeria, Norway, Oman, Pakistan, Panama,
Paraguay, Peru, Philippines, Poland, Portugal, , Romania, San Marino, Saudi Arabia, Senegal, Singapore,
Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Taiwan, Tanzania, Thailand,
Trinidad & Tobago, Turkey, Ukraine, United Arab Emirates, the United Kingdom, the United States, Uruguay,
Venezuela, Vietnam, Virgin Islands

587259-001

Intel Core processor i7- 620M, 2.26-GHz, 4-MB cache

593533-001

Realtek RTL8191SE 802.11b/g/n WiFi Adapter

593572-001

Battery, é-cell, 47 Wh, 2.2 Ah for use in computers with 15.6-in displays

593573-001

Battery, 9-cell, 93 Wh, 2.8 Ah for use in computers with 15.6-in displays

593576-001

Battery, 8-cell, 73 Wh, 2.55 Ah for use in computers with 17.3-in displays

593836-001

Broadcom 4313AGN 802.11a/b/g/draft-n WiFi Adapter for use in Afghanistan, Albania, Algeria, Andorra,
Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, Bahamas,
Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and
Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia,
Cameroon, Canada, Cape Verde, the Cayman Islands, Central African Republic, Chad, People's Republic of
China, Colombia, Comoros, Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti,
Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritreq,
Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana,
Gibraltar, Greece, Grenada, Guadeloupe, Guam, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti,
Honduras, Hong Kong, Hungary, Iceland, India, Iraq, Ireland, Israel, ltaly, Ivory Coast, Jamaica, Japan,
Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Martinique,
Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, Maldives, Mali, Malta,
Marshall Islands, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco,
Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua,
Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Puerto Rico, Peru,
Philippines, Poland, Portugal, Qatar, Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino,
Sao Tome and Principe, Saudi Arabia, Senegal, Serbia and Montenegro, Seychelles, Sierra Leone,
Singapore, Slovakia, Slovenia, Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St.
Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Syria,
Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan,
Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, the United States, the US
Virgin Islands, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe
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594187-001 Intel Core processor i3- 520M, 2.4-GHz, 3-MB L3 cache

594188-001 Intel Core processor i3-540M, 2.53-GHz, 3-MB L3 cache

597622001 Intel Core processor i3-330M, 2.13-GHz, 3-MB L3 cache

597623-001  Intel Core processor i3-350M, 2.26-GHz, 3-MB L3 cache

597624-001 Intel Core processor i5-430M, 2.26-GHz, 3-MB L3 cache

598667-001  System board with UMA graphics subsystem memory with RTC battery

598668-001  System board with discrete graphics subsystem memory with RTC battery

598669-001  System board with UMA graphics subsystem memory with WWAN and RTC battery
598670001  System board with discrete graphics, WWAN capability, and RTC battery for use in 4720s models
598671-001  Webcam module

598672-001  Screw Kit

598673-001  Plastics Kit, includes ExpressCard bezel, optical drive bezel, and RJ-11 dummy door
598674-001  Switch cover with power button switch for use in computers with 15.6-in displays and black or red trim
598675-001  Switch cover with power button switch for use in computers with 17.3-in displays
598677001  Fan/heat sink assembly for computers with discrete graphics

598678-001  Rubber Kit, includes: 4 rubber feet, 2 back edge screw covers and 4 mylar screw covers for LCD bezel
598679-001  Display Hinge Kit for use in computers with 15.6-in display

598680-001  Base enclosure for use in computers with 15.6-in displays

598681-001  Base enclosure for use in computers with 17.3-in displays

598682001  Top cover for use in computers with 15.6-in displays

598683-001  Top cover for use in computers with 17.3-in displays

598684-001  Audio board

598685-001  Speaker Kit for use in computers with 15.6-in displays

598686-001  Speaker Kit for use in computers with 17.3-in displays

598687-001  Optical drive extender for use only in computers with 17.3-in displays

598688-001  Palm rest for use in computers with 15.6-in displays with cable but without fingerprint reader
598689-001  Palm rest for use in computers with 17.3-in displays with cable but without fingerprint reader
598690-001  Display bezel for use in computers with 15.6-in displays without webcam

598691-001  Keyboard for use in the United States on computers with 15.6-in displays

598691-031  Keyboard for use in the United Kingdom on computers with 15.6-in displays

598691-041  Keyboard for use in Germany on computers with 15.6-in displays

598691-051  Keyboard for use in France on computers with 15.6-in displays

Sequential part number listing
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598691-061

Keyboard for use in ltaly on computers with 15.6-in displays

598691-071

Keyboard for use in Spain on computers with 15.6-in displays

598691-081

Keyboard for use in Denmark on computers with 15.6-in displays

598691-091

Keyboard for use in Norway on computers with 15.6-in displays

598691-121

Keyboard for use in French Canada on computers with 15.6-in displays

598691-131

Keyboard for use in Portugal on computers with 15.6-in displays

598691-141

Keyboard for use in Turkey on computers with 15.6-in displays

598691-161

Keyboard for use in Latin America on computers with 15.6-in displays

598691-171

Keyboard for use in Saudi Arabia on computers with 15.6-in displays

598691-201

Keyboard for use in Brazil on computers with 15.6-in displays

598691-211

Keyboard for use in Hungary on computers with 15.6-in displays

598691-251

Keyboard for use in Russia on computers with 15.6-in displays

598691-261

Keyboard for use in Bulgaria on computers with 15.6-in displays

598691-281

Keyboard for use in Thailand on computers with 15.6-in displays

598691-291

Keyboard for use in Japan on computers with 15.6-in displays

598691-A41

Keyboard for use in Europe on computers with 15.6-in displays

598691-A81

Keyboard for use in the Czech Republic on computers with 15.6-in displays

598691-AB1

Keyboard for use in Taiwan on computers with 15.6-in displays

598691-AD1

Keyboard for use in South Korea on computers with 15.6-in displays

598691-B31

Keyboard for International use on computers with 15.6-in displays

598691-B71

Keyboard for use in Finland on computers with 15.6-in displays

598691-BA1

Keyboard for use in Slovenia on computers with 15.6-in displays

598691-BB1

Keyboard for use in Israel on computers with 15.6-in displays

598691-BG1

Keyboard for use in Switzerland on computers with 15.6-in displays

598691-DD1

Keyboard for use in Iceland on computers with 15.6-in displays

598691-DJ1

Keyboard for use in Greece on computers with 15.6-in displays

598691-DW1

Keyboard for use in French Arabic region on computers with 15.6-in displays

598692-001

Keyboard for use in the United States on computers with 17.3-in displays

598692-031

Keyboard for use in the United Kingdom on computers with 17.3-in displays

598692-041

Keyboard for use in Germany on computers with 17.3-in displays

598692-051

Keyboard for use in France on computers with 17.3-in displays

598692-061

Keyboard for use in ltaly on computers with 17.3-in displays
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598692-071  Keyboard for use in Spain on computers with 17.3-in displays
598692-081  Keyboard for use in Denmark on computers with 17.3-in displays
598692091  Keyboard for use in Norway on computers with 17.3-in displays
598692-121  Keyboard for use in French Canada on computers with 17.3-in displays
598692-131  Keyboard for use in Portugal on computers with 17.3-in displays
598692-141  Keyboard for use in Turkey on computers with 17.3-in displays
598692-161  Keyboard for use in Latin America on computers with 17.3-in displays
598692-171  Keyboard for use in Saudi Arabia on computers with 17.3-in displays
598692201  Keyboard for use in Brazil on computers with 17.3-in displays
598692211  Keyboard for use in Hungary on computers with 17.3-in displays
598692251  Keyboard for use in Russia on computers with 17.3-in displays
598692261  Keyboard for use in Bulgaria on computers with 17.3-in displays
598692281  Keyboard for use in Thailand on computers with 17.3-in displays
598692291  Keyboard for use in Japan on computers with 17.3-in displays
598692-A41  Keyboard for use in Europe on computers with 17.3-in displays
598692-A81 Keyboard for use in the Czech Republic on computers with 17.3-in displays
598692-AB1  Keyboard for use in Taiwan on computers with 17.3-in displays
598692-AD1  Keyboard for use in South Korea on computers with 17.3-in displays
598692831  Keyboard for International use on computers with 17.3-in displays
598692871  Keyboard for use in Finland on computers with 17.3-in displays
598692-BA1  Keyboard for use in Slovenia on computers with 17.3-in displays
598692-BB1  Keyboard for use in Israel on computers with 17.3-in displays
598692BG1  Keyboard for use in Switzerland on computers with 17.3-in displays
598692-DD1  Keyboard for use in Iceland on computers with 17.3-in displays
598692D])1  Keyboard for use in Greece on computers with 17.3-in displays
598692-DW1  Keyboard for use in French Arabic region on computers with 17.3-in displays
598693-001  DVD-ROM drive with bezel

598694-001  DVD+RW Double-layer Drive with LightScribe

598695-001  Blu-ray Disc ROM Drive with SuperMulti DVD+R/RW Double-Layer
598696-001  250-GB, 7200 rpm hard drive (includes hard drive bracket)
598697001  320-GB, 7200 rpm hard drive (includes hard drive bracket)
598698-001  500-GB, 7200 rpm hard drive (includes hard drive bracket)
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598699-001

750-GB, 5400 rpm hard drive (includes hard drive bracket)

598702-001

15.6-in HD AntiGlare display assembly for use in computers with black trim

598703-001

15.6-in HD AntiGlare display assembly for use in computers with webcam and black trim

598704-001

15.6-in HD AntiGlare display assembly for use in computers with webcam, WWAN, and black trim

598705-001

15.6-in HD BrightView display assembly for use in computers with black trim

598706-001

15.6-in HD BrightView display assembly for use in computers with a webcam and black trim

598707-001

15.6-in HD BrightView display assembly for use in computers with a webcam, WWAN, and black trim

598708-001

17.3-in HD BrightView display assembly for use in computers with a webcam and WWAN

598856-001

Memory module, 2-GB (PC3-10600, 1333-MHz, DDR3)

598859-001

Memory module, 1-GB (PC3-10600, 1333-MHz, DDR3)

599080-001

17.3-in HD+ AntiGlare display assembly (1600x900 resolution)

599092-001

Memory module, 4-GB (PC3-10600, 1333-MHz, DDR3)

599804-001

Palm rest for use in computers with 15.6-in displays with TouchPad, fingerprint reader, and cables

599805-001

Palm rest for use in computers with 17.3-in displays with TouchPad, fingerprint reader, and cables

599806-001

Misc LCD Cable Kit, includes microphone, WLAN, and WWAN cables for computers with 15.6-in displays

599807-001

Base Cable Kit for use in computers with 15.6-in displays, includes: RJ-11 cable, modem cable, Bluetooth
cable, and DC-in cable

600370001

Broadcom 4313 802.11b/g/n 1x1 WiFi and 2070 Bluetooth 2.1+EDR Combo Adapter for use in
Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba,
Australia, Austria, Azerbaijan, Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin,
Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei,
Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Canada, Cape Verde, the Cayman Islands, Central
African Republic, Chad, Chile, the People's Republic of China, Colombia, Comoros, Congo, Costa Rica,
Croatia, Cyprus, Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor,
Ecuador, Egypt, El Salvador, Equitorial Guineaq, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French
Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guam,
Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India,
Indonesia, Iraq, Ireland, Israel, ltaly, Ivory Coast, Jamaica, Japan, Jordan, Kazakhstan, Kenya, Kiribati,
Kuwait, Kyrgyzstan, Laos, Latvia, Llebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Madagascar, Malawi, Malaysia, Maldives, Mali, Malta, Marshall Islands, Martinique, Mauritania, Mauritius,
Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the
Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan,
Palau, Panama, Papua New Guinea, Paraguay, Peru, Philippines, Poland, Portugal, Puerto Rico, Qatar, the
Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia,
Senegal, Serbia and Montenegro, Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, Solomon Islands,
Somalia, South Africa, South Korea, Sri Llanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines,
Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad
and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United
Kingdom, the United States, Uruguay, the US Virgin Islands, Uzbekistan, Vanuatu, Venezuela, Vietnam,
Yemen, Zaire, Zambia, and Zimbabwe

600924-001

Display bezel for use in computers with 17.3-in displays without webcam

600925-001

LCD Cable with webcam cable for use in computers with 15.6-in displays

600926-001

Display bezel for use in computers with 15.6-in displays with a webcam
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600927-001  Display bezel for use in computers with 17.3-in displays with a webcam

600928-001  Display enclosure for use in computers with 15.6-in displays

600929-001  Display enclosure for use in computers with 17.3-in displays

602677001  Hinge Kit for use in computers with 17.3-in displays

602992-001  Ralink RT3090BC4 802.11b/g/n 1x1 WiFi and Bluetooth 2.1+EDR Combo Adapter for use in Afghanistan,
Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria,
Azerbaijan, Bahamas, Bahrain, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia
and Herzegovina, Botswana, Brazil, British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi,
Cambodia, Cameroon, Canada, Cape Verde, the Cayman Islands, Central African Republic, Chad, Chile,
the People's Republic of China, Colombia, Comoros, Congo, Costa Rica, Croatia, Cyprus, the Czech
Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador,
Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia,
Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guam, Guatemala, Guinea, Guinea-Bissa,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, ltaly, Ivory Coast,
Jamaica, Japan, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, latvia, Lebanon, Lesotho,
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, Maldives, Mali,
Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia,
Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guineaq,
Paraguay, Peru, the Philippines, Poland, Portugal, Puerto Rico, the Republic of Moldova, Romania, Russia,
Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia and Montenegro,
Seychelles, Sierra leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South
Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and Grenadines, Suriname, Swaziland,
Sweden, Switzerland, Syria, Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad and Tobago,
Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom,
Uruguay, the US Virgin Islands, the United States, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire,
Zambia, and Zimbabwe

602999-001  LCD Cable Kit for use in computers with 17.3-in displays

603188-001  Base Cable Kit for use in computers with 17.3-in displays

603700-001  Thermal shield

604852-001  Palm rest for use in computers with 15.6 displays and red trim

604853-001  Switch cover with power button switch for use in computers with 15.6 displays and red trim

604854-001  15.6-in HD AntiGlare display assembly for use in computers with red trim (1366x768 resolution)

604855-001  15.6-in HD AntiGlare display assembly for use in computers equipped with webcam and red trim (1366x768
resolution)

604856-001  15.6-in HD AntiGlare display assembly for use in computers equipped with webcam, WWAN, and red trim
(1366x768 resolution)

604857001  15.6-in HD BrightView display assembly for use in computers with red trim (1366x768 resolution)

604858-001  15.6-in HD BrightView display assembly for use in computers equipped with webcam and red trim
(1366x768 resolution)

604859-001  15.6-in HD BrightView display assembly for use in computers equipped with webcam, WWAN, and red trim
(1366x768 resolution)

604861-001  Palm rest for use in computers with 15.6 displays and red trim

605168-001  System board with UMA graphics subsystem memory for use only in the People's Republic of China and

Russia
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605169-001

System board with discrete graphics subsystem memory for use only in the People's Republic of China and
Russia

605170-001

System board with UMA graphics subsystem memory and WWAN for use only in the People's Republic of
China and Russia

605171-001

System board with discrete graphics, WWAN capability, and RTC battery for use only in the People's
Republic of China and Russia

606165-001

17.3-in HD AntiGlare display assembly (1600x900 resolution)

606166-001

17.3-in HD AntiGlare display assembly for use in computers equipped with webcam and WWAN
(1600x900 resolution)

606167-001

17.3-in HD BrightView display assembly (1600x900 resolution)

606972001

LCD cable without webcam cable for use in computers with 15.6-in displays

606973-001

LCD cable without webcam cable for use in computers with 17.3-in displays

606974-001

Misc LCD Cable Kit for use in computers with 17.3-in displays

607132001

Fan/heat sink assembly for use in computers with UMA graphics subsystems

607133-001

Display enclosure for use in computers with 15.6-in displays and red trim

609948-001

65-W Smart AC adapter with power factor correction (PFC), RC/V EM 3W for use in the Asia-Pacific region

609952-001

Power button board

611699001

Intel Celeron P4500 processor (1.86-GHz, 2-MB, L2 cache)

613152001

65-W AC adapter for use in computers with UMA graphics

613153001

90-W Slimline PFC AC adapter for use in computers with discrete graphics

613161-001

65-W Smart AC adapter with power factor correction (PFC), RC/V EM 3W for use in the Asia-Pacific region

613584-001

Intel Core i5-370M processor, 2.40-GHz, 3-MB L3 cache

613585-001

Intel Core i5-450M processor, 2.40-GHz, 3-MB L3 cache

613586-001

Intel Pentium P6000 processor, 1.86-GHz, 3-MB L3 cache

613587001

Intel Pentium P6100 processor, 2.00-GHz, 3-MB L3 cache

616073-001

RTC battery

617667001

640-GB, 5400-rpm hard drive

623182001

15.6-in HD BrightView LVDS display assembly for use in computers with black trim (1366x768 resolution)

624238001

15.6-in HD SVA LVDS AntiGlare display assembly for use in computers with black trim (1366x768 resolution)

624643-001

15.6-in WVA LVDS HD AntiGlare display assembly for use in computers with black trim (1366x768

resolution)

625823-001

Intel Core i3-380M processor, 2.53-GHz, 3-MB L3 cache

625831-001

Intel Pentium P6200 processor, 2.13-MHz, 3-MB L3 cache

626039001

Intel Core i5-460M processor, 2.53-GHz, 3-MB L3 cache

626113-001

Palm rest for use in computers with 15.6 displays and champagne-colored trim
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626114-001  Switch cover with power button switch for use in computers with 15.6-in displays and champagne-colored trim

626115-001  15.6-in HD AntiGlare display assembly for use in computers with champagne-colored trim (1366x768
resolution)

626116-001  15.6-in HD AntiGlare display assembly for use in computers equipped with webcam and champagne-colored
trim (1366x768 resolution)

626117-001  15.6-in HD AntiGlare display assembly for use in computers equipped with webcam, WWAN, and
champagne-colored trim (1366x768 resolution)

626118-001  15.6-in HD BrightView display assembly for use in computers with champagne-colored trim (1366x768
resolution)

626119-001  15.6-in HD BrightView display assembly for use in computers with webcam and champagne-colored trim
(1366x768 resolution)

626120-001  15.6-in HD BrightView display assembly for use in computers with webcam, WWAN, and champagne-
colored trim (1366x768 resolution)

628794-001  System board with ATl Mobility Radeon HD 5470 graphics for use in 4720s models

628795-001  System board with ATl Mobility Radeon HD 5470 graphics for use in 4520s models

629030-001  Display cable, HD+
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4 Removal and replacement
procedures

Preliminary replacement requirements

Tools required
You will need the following tools to complete the removal and replacement procedures:
®  Flat-bladed screwdriver
®  Magnetic screwdriver
e  Phillips PO and P1 screwdrivers

o  Torx T8 screwdriver

Service considerations

The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

Ef NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

A CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use
care when handling the plastic parts. Apply pressure only at the points designated in the maintenance
instructions.
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Cables and connectors

A CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with
extreme care; these cables tear easily.

Drive handling

A CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.
Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.
Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

A CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.
Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

A CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

Relative humidity

Event 10% 40% 55%
Walking across carpet 35,000 V 15,000 V 7,500 V
Walking across vinyl floor 12,000 V 5,000 V 3,000 V
Motions of bench worker 6,000 V 800 V 400V
Removing DIPS from plastic tube 2,000V 700V 400V
Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V
Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V
Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V
Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.
Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

Place items on a grounded surface before removing items from their containers.

Always be properly grounded when touching a component or assembly.

Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

Cover the workstation with approved static-shielding material.

Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

Avoid contact with pins, leads, or circuitry.

Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines
Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

®  When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm £10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

®  When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips must
be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:
e Antistatic tape

®  Antistatic smocks, aprons, and sleeve protectors

e  Conductive bins and other assembly or soldering aids

®  Nonconductive foam

e  Conductive tabletop workstations with ground cords of one megohm resistance
e  Static-dissipative tables or floor mats with hard ties to the ground

e  Field service kits

e  Static awareness labels

®  Material-handling packages

e Nonconductive plastic bags, tubes, or boxes

®  Mefal tote boxes

e  Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level
Antistatic plastic Bags 1,500 V
Carbon-loaded plastic Floor mats 7,500 V
Metallized laminate Floor mats 5,000V
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Component replacement procedures

This section provides removal and replacement procedures.

There are many screws, in many different sizes, that must be removed, replaced, or loosened when
servicing the computer. Make special note of each screw size and location during removal and
replacement.

Service tag

When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag:

(1) Product name: This is the product name affixed to the front of the computer.
(2) Serial number (s/n): This is an alphanumeric identifier that is unique to each product.

3) Part number/product number (p/n): This number provides specific information about the product's
p P p p p

hardware components. The part number helps a service technician to determine what components and
p p p p

parts are needed.

(4) Model description: This is the alphanumeric identifier used to locate documents, drivers, and
support for the computer.

(5) Warranty period: This number describes the duration of the warranty period for this computer.

o—i product © XX00000000ENK K00
B—sln sxoococooes  IITHAINANANENENNIN

e__lﬂl'l e (1T TIV I fRATEE T Tl

SEMVISE | X000
tag | warranty x year

00
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Computer feet

The computer feet are adhesive-backed rubber pads. The feet are included in the Rubber Kit, spare part
number 598678-001. There are 4 rubber feet that attach to the base enclosure in the locations
illustrated below.
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Battery

Description Spare part number
8-cell, 73-Wh, 2.55-Ah Li-on battery for use in computers with 17.3-in displays 593576-001
6-cell, 47-Wh, 2.2-Ah Li-on battery for use in computers with 15.6-in displays 593572001
6-cell, 93-Wh, 2.8-Ah Li-on battery for use in computers with 15.6-in displays 593573-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery:
1. Turn the computer upside-down on a flat surface with the battery bay toward you.
2. Slide the battery release latches (1) to release the battery.

3. Remove the battery (2) from the computer.

Install the battery by inserting it into the battery bay until you hear a click.
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Switch cover and keyboard

Description Spare part number

Switch cover with power button board

For use in computers with 17.3-in displays 598675001
For use in computers with 15.6-in displays and black or red trim 598674-001
For use in computers with 15.6-in displays and champagne-colored trim 626114001
Keyboards for use in computers with 17.3-in displays 598692-xx]1
Keyboards for use in computers with 15.6-in displays 59869 1-xx1

NOTE: For a detailed list of available keyboards, see Sequential part number listing on page 38.

Before removing the switch cover and keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 55).
Remove the switch cover and keyboard:

1. Position the computer upside-down with the rear toward you.
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2. To remove the switch cover, remove the following:
(1) Two screw covers on the rear edge of the computer
(2) Two PM2.5x2.5 screws
(3) Three PM2.0x2.5 broadhead screws located in the battery bay

3. Open the computer as far as possible.

4. Slide the switch cover back (1), and then remove it from the computer (2).
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5. Remove the two Phillips PM2.5x5.0 screws that secure the keyboard to the computer.

6. Slide the keyboard back toward the display (1), and then rotate it forward (2) until it rests upside-
down on the palm rest.

7. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached, and
disconnect the keyboard cable (2) from the system board.

B NOTE: Only disconnect the keyboard cable from the system board when replacing the
keyboard or removing the top cover. It is not recommended that you disconnect the cable unless it
is absolutely necessary.
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8. Remove the keyboard (3).

Reverse this procedure to install the switch cover and keyboard.
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Memory module

Ef NOTE: When adding a second memory module, be sure it is the same type and speed as the
installed memory module.

Description Spare part number
4-GB (PC3-10600, 1333-MHz, DDR3) 599092-001
2-GB (PC3-10600, 1333-MHz, DDR3) 598856-001
1-GB (PC3-10600, 1333-MHz, DDR3) 598859-001

Before removing the memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 55).

5. Remove the switch cover and keyboard (see Switch cover and keyboard on page 56).

B NOTE: It is not necessary to disconnect the keyboard cable from the system board to remove the
memory modules.

Remove the memory module:
1. Position the computer right-side up with the front toward you.

2. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)
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3. Remove the memory module (2) by pulling the module away from the slot at an angle.

Ef NOTE: Memory modules are designed with a notch to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install a memory module.

Optical drive

B NOTE: All optical drive spare part kits include an optical drive bezel.

Description Spare part number
DVD=RW Double-Layer Drive with LightScribe (includes bezel) 598694001
Blu-ray Disc ROM Drive with SuperMulti DVD+R/RW Double-Layer (includes bezel) 598695-001
DVD-ROM Drive (includes bezel) 598693-001

Before removing the optical drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.
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4. Remove the battery (see Battery on page 55).

5. Remove the switch cover and keyboard (see Switch cover and keyboard on page 56).

B NOTE: It is not necessary to disconnect the keyboard cable from the system board to remove the
optical drive.

Remove the optical drive:
1. Position the computer with the right side toward you.
2. Remove the Phillips PM2.5x5.0 screw (1) that secures the optical drive to the computer.

3. Insert a flat-bladed screwdriver or similar tool into the optical drive tab access (2) and press the
tab to the right to release the optical drive from the computer.

4. Remove the optical drive (3) from the computer.

B’ NOTE: 15.6-in model shown below

5. |Ifitis necessary to replace the optical drive bracket, position the optical drive with the rear toward
you.

6. Remove the two Phillips PM2.0x2.0 screws (1) that secure the optical drive bracket to the optical
drive.
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7. Remove the optical drive bracket (2).

Reverse this procedure to reassemble and install an optical drive.

Power button board

Description Spare part number

Switch cover with power button board

For use in computers with 17.3-in displays 598675-001
For use in computers with 15.6-in displays and black or red trim 598674001
For use in computers with 15.6-in displays and champagne-colored trim 626114001

Before removing the power button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 55).

5. Remove the switch cover and keyboard (see Switch cover and keyboard on page 56).
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Remove the power button board.

1. Release the ZIF connector (1) and disconnect the ribbon cable (2) from the system board.

2. Remove the screw (1) that secures the power button board to the base pan and the slide the
board out of the retainer (2) to the left (3) to remove it.

Reverse this procedure to install the power button board.
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Speakers

Description Spare part number
For use in computers with 17.3-in displays 598686-001
For use in computers with 15.6-in displays 598685-001

Before removing the speakers, follow these steps:

4.
5.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 55).

Disconnect the power button cable from the system board (see Power button board on page 63).

Remove the speakers from the 17.3-in computer:

1.
2.

Remove the two PM2.5x6.0 screws (1) that secure the speakers to the top cover.

Disconnect the speaker cable from the connector (2) on the system board.
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3. Remove the cables from the routing channels and lift the speakers (3) from the computer.

Remove the speakers from the 15.6-in computer:
1. Remove the two PM2.5x6.0 screws (1) that secure the speakers to the top cover.

2. Disconnect the speaker cable connector (2) from the system board.
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3. Remove the cables from the routing channels and the speakers (3) from the computer.

Reverse this procedure to install the speakers.

Thermal shield
B NOTE: The spare part number for the thermal shield is 603700-001.

Before removing the thermal shield, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 55).

5. Remove the switch cover and keyboard (see Switch cover and keyboard on page 56).

Ef NOTE: It is not necessary to disconnect the keyboard cable from the system board before
removing the thermal shield.
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Remove the thermal shield on the 17.3-in computer:
1. Position the computer rightside up with the front toward you.
2. Remove the PM2.5x3.0 screw (1) from the thermal shield.

3. Raise the thermal shield (2) and remove it (3) from the computer.

Remove the thermal shield on the 15.6-in computer:
1. Position the computer rightside up with the front toward you.
2. Remove the two PM2.5x3.0 screws (1) and (2) from the thermal shield.

3. Raise the thermal shield (3) and remove it (4) from the computer.
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Reverse this procedure to reassemble and install an optical drive.
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WLAN module

Description Spare part number

Intel Centrino Advanced-N6200 802.11 a/b/g/n 2x2 572509001

For use in Andorra, Antigua & Barbuda, Argentina, Australia, Austria, Azerbaijan, Bahamas,
Bahrain, Barbados, Belgium, Bolivia, Bosnia & Herzegovina, Brazil, Brunei, Bulgaria, Canada,
Chile, China, Colombia, Costa Rica, Croatia, Cyprus, Czech Republic, Denmark, Dominican
Republic, Ecuador, Egypt, El Salvador, Estonia, Finland, France, Georgia, Germany, Ghana,
Greece, Guam, Guatemala, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia,
Ireland, Israel, Italy, Ivory Coast, Jamaica. Japan, Jordan, Kenya, South Korea, Kuwait, Kyrgyzstan,
Latvia, Lebanon, Martinique, Nether Antilles, Puerto Rico, French Guiana, Guadeloupe, Cayman
Islands, Bermuda, Aruba, Liechtenstein, Lithuania, Luxembourg, Malawi, Malaysia, Maltq,
Mauritius, Mexico, Monaco, Montenegro, Morocco, Netherlands, New Zealand, Nicaragug,
Nigeria, Norway, Oman, Pakistan, Panama, Paraguay, Peru, Philippines, Poland, Portugal, Qatar,
Romania, San Marino, Saudi Arabia, Senegal, Singapore, Slovakia, Slovenia, South Africa, Spain,
Sri Lanka, Sweden, Switzerland, Taiwan, Tanzania, Thailand, Trinidad & Tobago, Tunisia, Turkey,
United Arab Emirates, the United Kingdom, the United States, Uruguay, Venezuela, Vietnam, Virgin
Islands

Intel Centrino Wireless-N1000 802.11 b/g 1x2 585984-001

For use in Andorra, Antigua & Barbuda, Argentina, Aruba, Australia, Austria, Azerbaijan,
Bahamas, Bahrain, Barbados, Belgium, Bermuda, Bolivia, Bosnia & Herzegovina, Brazil, Brunei,
Bulgaria, Canada, Cayman Islands, Chile, China, Colombia, Costa Rica, Croatia, Cyprus, Czech
Republic, Denmark, Dominican Republic, Ecuador, Egypt, El Salvador, Estonia, Finland, France,
French Guiana, Georgia, Germany, Ghana, Greece, Guadeloupe. Guatemala, Haiti, Honduras,
Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, ltaly, Ivory Coast, Jamaica, Japan,
Jordan, Kenya, South Korea, Kuwait, Kyrgyzstan, Latvia, Lebanon, Nether Antilles, Martinique,
Puerto Rico, Guam, Liechtenstein, Lithuania, Luxembourg, Malawi, Malaysia, Malta, Mauritius,
Mexico, Monaco, Montenegro, Netherlands, New Zealand, Nicaragua, Nigeria, Norway, Oman,
Pakistan, Panama, Paraguay, Peru, Philippines, Poland, Portugal, , Romania, San Marino, Saudi
Arabia, Senegal, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden,
Switzerland, Taiwan, Tanzania, Thailand, Trinidad & Tobago, Turkey, Ukraine, United Arab
Emirates, the United Kingdom, the United States, Uruguay, Venezuela, Vietnam, Virgin Islands

Broadcom 4312 802.11b/g WLAN modules

For use in Antigua and Barbuda, Barbados, Belize, Canada, the Cayman Islands, Guam, Puerto 504593-003
Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United States
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Description Spare part number

For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argenting, 504593-004
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana,
Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde,
the Central African Republic, Chad, Chile, the People's Republic of China, Colombia, Comoros, the
Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the
Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia,
Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana,
Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti,
Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, ltaly, the Ivory Coast, Jamaica,
Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberiq,
Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives,
Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia,
Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether
Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan,
Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the
Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe,
Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the
Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St.
Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvaly,
Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu,
Venezuela, Vietham, Yemen, Zaire, Zambia, and Zimbabwe

Atheros 9285G 802.11 b/g/n WiFi Adapter for use in all countries and regions 605560-005
Realtek RTL8BAISE 802.11b/g/n WiFi Adapter for use in all countries and regions 593533-001
Intel Wi-Fi Link 1000, 802.11b/g/n WLAN module 572520-001

For use in Andorra, Antigua and Barbuda, Argentina, Aruba, Australia, Austria, Azerbaijan, the
Bahamas, Barbados, Belgium, Bolivia, Bosnia and Herzegovina, Brazil, Brunei, Bulgaria, Canada,
Cayman Islands, Chile, China, Colombia, Costa Rica, Croatia, Cyprus, the Czech Republic,
Denmark, the Dominican Republic, Ecuador, Egypt, El Salvador, Estonia, Finland, France, French
Guiana, Guadeloupe, Guam, Georgia, Germany, Ghana, Greece, Guatemala, Haiti, Honduras,
Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, ltaly, Ivory Coast, Jamaica, Japan,
Jordan, Kenya, Kuwait, Kyrgyzstan, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malawi,
Malaysia, Malta, Martinique, Mauritius, Mexico, Monaco, Montenegro, Morocco, the Nether
Antilles, the Netherlands, New Zealand, Nicaragua, Nigeria, Nigeria, Oman, Pakistan, Panama,
Paraguay, Peru, the Philippines, Poland, Portugal, Puerto Rico, Quatar, Romania, San Marino,
Saudi Arabia, Senegal, Singapore, Slovakia, Slovenia, South Africa, South Korea, Spain, Sri
Lanka, Sweden, Switzerland, Taiwan, Tanzania, Thailand, Trinidad and Tobago, Turkey, United
Arab Emirates, the United Kingdom, the United States, Uruguay, the U.S. Virgin Islands, Venezuela,
and Vietnam

Broadcom 4322 AGN, 802.11a/b/g/n

For use in Antigua and Barbuda, Barbados, Belize, Canada, the Cayman Islands, Guam, Puerfo 518434-001
Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United States
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Description Spare part number

For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina, 518434-002
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana,
Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde,
the Central African Republic, Chad, Chile, the People's Republic of China, Colombia, Comoros, the
Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the
Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia,
Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana,
Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea- Bissau, Guyana, Haiti,
Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, ltaly, the Ivory Coast, Jamaica,
Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, latvia, Lebanon, Lesotho, Liberia,
Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives,
Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia,
Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether
Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan,
Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the
Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe,
Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra leone, Singapore, Slovakia, Slovenia, the
Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St.
Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu,

Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay,

Broadcom 4313AGN 802.11a/b/g/draft-n WiFi Adapter 593836-001

For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana,
Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon,
Canada, Cape Verde, the Cayman Islands, Central African Republic, Chad, People's Republic of
China, Colombia, Comoros, Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark,
Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial
Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia,
Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guam, Guatemala, Guinea, Guinea-
Bissa, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Iraq, Ireland, Israel, ltaly,
Ivory Coast, Jamaica, Japan, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos,
Latvia, Lebanon, Lesotho, Liberia, Martinique, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Madagascar, Malawi, Malaysia, Maldives, Mali, Malta, Marshall Islands, Mauritania, Mauritius,
Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru,
Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway,
Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Puerto Rico, Peru, Philippines,
Poland, Portugal, Qatar, Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino,
Sao Tome and Principe, Saudi Arabia, Senegal, Serbia and Montenegro, Seychelles, Sierra Leone,
Singapore, Slovakia, Slovenia, Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri
Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland,
Sweden, Switzerland, Syria, Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad and
Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the
United Kingdom, Uruguay, the United States, the US Virgin Islands, Uzbekistan, Vanuatu,
Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

Broadcom 4313 802.11b/g/n 1x1 WiFi and 2070 Bluetooth 2.1+EDR Combo 600370001
Adapter
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Description Spare part number

For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana,
Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon,
Canada, Cape Verde, the Cayman Islands, Central African Republic, Chad, Chile, the People's
Republic of China, Colombia, Comoros, Congo, Costa Rica, Croatia, Cyprus, Czech Republic,
Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador,
Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia,
Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guam, Guatemala,
Guinea, Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia,
Iraq, Ireland, Israel, ltaly, Ivory Coast, Jamaica, Japan, Jordan, Kazakhstan, Kenya, Kiribati,
Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagascar, Malawi, Malaysia, Maldives, Mali, Malta, Marshall Islands, Martinique,
Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco,
Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand,
Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea,
Paraguay, Peru, Philippines, Poland, Portugal, Puerto Rico, Qatar, the Republic of Moldova,
Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal,
Serbia and Montenegro, Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, Solomon Islands,
Somalia, South Africa, South Korea, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the
Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Thailand,
Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the
United Arab Emirates, the United Kingdom, the United States, Uruguay, the US Virgin Islands,
Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

Ralink RT3090BC4 802.11b/g/n 1x1 WiFi and Bluetooth 2.1+EDR Combo Adapter 602992-001

For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, Bahamas, Bahrain, Barbados, Belarus, Belgium,
Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, British Virgin
Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Canada, Cape Verde, the
Cayman Islands, Central African Republic, Chad, Chile, the People's Republic of China, Colombia,
Comoros, Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica,
the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea,
Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany,
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guam, Guatemala, Guinea, Guinea-Bissa,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy,
Ivory Coast, Jamaica, Japan, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos,
Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar,
Malawi, Malaysia, Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius,
Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru,
Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway,
Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland,
Portugal, Puerto Rico, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino,
Sao Tome and Principe, Saudi Arabia, Senegal, Serbia and Montenegro, Seychelles, Sierra Leone,
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri
Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and Grenadines, Suriname, Swaziland, Sweden,
Switzerland, Syria, Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad and Tobago,
Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United
Kingdom, Uruguay, the US Virgin Islands, the United States, Uzbekistan, Vanuatu, Venezuela,
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

A CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless devices
in your country or region. If you replace the module and then receive a warning message, remove the
module to restore computer functionality, and then contact technical support through Help and Support.
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Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 55).

5. Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 56)

b. Thermal shield (see Thermal shield on page 67)

Remove the WLAN module:
1. Position the computer rightside up with the front toward you.

2. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

B NOTE: The black WLAN antenna cable is connected to the WLAN module “Main” terminal. The
white WLAN antenna cable is connected to the WLAN module “Aux” terminal.

3. Remove the two Phillips PM2.0x4.0 screws (2) that secure the WLAN module to the computer.
(The edge of the module opposite the slot rises away from the computer.)
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4. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

EY NOTE: WLAN modules are designed with a notch (4) to prevent incorrect insertion.

Reverse this procedure to install the WLAN module.
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WWAN module

B NOTE: Only computers with UMA graphics include @ WWAN module.

NOTE: The spare part number for the HP un2420 Broadband Module is 531993-001.

A CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless devices
in your country or region. If you replace the module and then receive a warning message, remove the
module fo restore computer functionality, and then contact technical support through Help and Support.

Before removing the WWAN module, follow these steps:

1.

4.
5.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 55).

Remove the switch cover and keyboard (see Switch cover and keyboard on page 56)

Remove the WWAN module:

1.
2,

3.

Position the computer right-side up with the front toward you.

Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.

B NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal.

The blue WWAN antenna cable is connected to the WWAN module “Aux” terminal. The
terminals and cables are both identified by number and color.

Remove the two Torx M2.5x6.0 screws (2) that secure the WWAN module to the computer. (The
edge of the module opposite the slot rises away from the computer.)

76 Chapter 4 Removal and replacement procedures



4. Remove the WWAN module (3) by pulling the module away from the slot at an angle.

B NOTE: WWAN modules are designed with a notch (4) to prevent incorrect insertion.

u
[
u
|
u
|
I

Reverse this procedure to install the WWAN module.

Component replacement procedures 77



Heat sink and fan

B NOTE: The heat sink spare part kit includes replacement thermal material.

Description Spare part number
Heat sink for use in computers with UMA graphics subsystems 598676-001
Heat sink for use in computers with discrefe graphics subsystems 598677-001

Before removing the heat sink, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 55).

5. Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 56).

b. Thermal shield (see Thermal shield on page 67).

Remove the heat sink:
®  For computers with discrete subsystem memory on the system board, follow these steps:
1. Position the computer rightside up with the front toward you.

2. Following the sequence stamped into the heat sink, loosen the six captive screws (1), (2), (3),
(4), (5), (6), around the processor.
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3. Disconnect the fan cable from the system board (7), and then remove the heat sink (8).

Component replacement procedures 79



4. Clean the thermal material from the surfaces of the heat sink components (1) and (3) and from the
system board (2) and (4) when the heat sink is removed. Replacement thermal material is
included with all heat sink, system board, and processor spare part kits.

e  For computers with UMA subsystem memory on the system board, follow these steps:
1. Position the computer rightside up with the front toward you.

2. Following the sequence stamped into the heat sink, loosen the four screws (1), (2), (3), (4)
around the processor.
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3. Disconnect the fan cable from the system board (5), and remove the heat sink (6).
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4. Clean the thermal material from the surfaces of the heat sink components (1) and the system
board (2) each time the heat sink is removed. Replacement thermal material is included with all
heat sink, system board, and processor spare part kits.

Reverse this procedure to install the heat sink and fan.
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Processor

Ef NOTE: The processor spare part kit includes replacement thermal material.

Description Spare part number

Intel Core processors:

i3-330M, 2.13-GHz 597622-001
i3-350M, 2.26-GHz 597623-001
i3-370M, 2.40-GHz 613584-001
i3-380M, 2.53-GHz 625823-001
i5-430M, 2.26-GHz 597624-001
i5-450M, 2.40-GHz 613585-001
i5-460M, 2.53-GHz 626039-001
i5-520M, 2.40-GHz 594187-001
i5-540M, 2.53-GHz 594188-001
i7-620M, 2.26-GHz 587259-001

Intel Pentium processors:

P6000, 1.86-GHz 613586-001
P6100, 2.00-GHz 613587-001
P6200, 2.13-GHz 625831-001

Intel Celeron processor:

P4500, 1.86-GHz 611699001

Before removing the processor, follow these steps:

1.

2.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 55).

Remove the switch cover and keyboard (see Switch cover and keyboard on page 56).

Remove the thermal shield (see Thermal shield on page 67).

Remove the heat sink and fan (see Heat sink and fan on page 78).
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Remove the processor:
1. Position the computer rightsside up with the front toward you.

2. Use a flat-bladed screwdriver to turn the processor locking screw (1) one-half turn
counterclockwise until you hear a click.

3. Lift the processor (2) straight up and remove it.

Ef NOTE: When you install the processor, the gold triangle (3) on the processor must be aligned
with the triangle (4) embossed on the processor socket.

Reverse this procedure to install the processor.

Palm rest
Description Spare part number
Palm rest for 17.3-in displays (includes TouchPad) 598689001
Palm rest for 17.3-in displays with fingerprint reader (includes TouchPad) 599805-001
Palm rest for 15.6-in displays (includes TouchPad) 598688001
Palm rest for 15.6-in displays with red trim (includes TouchPad) 604852-001
Palm rest for 15.6-in displays with fingerprint reader with black trim (includes TouchPad) 599804-001
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Description Spare part number

Palm rest for 15.6-in displays with fingerprint reader with red trim (includes TouchPad) 604861-001
Palm rest for 15.6-in displays with fingerprint reader with champagne-colored trim (includes 626113-001
TouchPad)

Before removing the palm rest, follow these steps:

4.
5.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 55).

Remove the switch cover and keyboard (see Switch cover and keyboard on page 56).

Remove the palm rest:

Position the computer right-side up with the front toward you.
Remove the three Phillips PM2.0x3.0 screws (1) that secure the palm rest to the computer.

Slide the palm rest to the right (2), and then lift and rotate the rear edge (3) towards the display
to gain access to the TouchPad cable.
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4. Release the ZIF connectors (1) and (3) to which the TouchPad and fingerprint cables are
connected, and then disconnect the cables (2) and (4) from the system board.

Ef NOTE: Only select models are equipped with fingerprint readers.

5. Remove the palm rest.

Reverse this procedure to install the palm rest.
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Hard drive

Ef NOTE: The hard drive spare part kit includes a hard drive bracket.

Description Spare part number
750-GB, 5400-rpm hard drive 598699-001
640-GB, 5400-rpm hard drive 617667-001
500-GB, 7200-rpm hard drive 598698-001
320-GB, 7200-rpm hard drive 598697-001
250-GB, 7200-rpm hard drive 598696-001

Before removing the hard drive, follow these steps:

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 55).

Remove the Switch cover and keyboard (see Switch cover and keyboard on page 56).

B NOTE: It is not necessary to remove the keyboard cable from the system board when removing

6.

the hard drive.

Remove the palm rest (see Palm rest on page 84).

Remove the hard drive:

Position the computer rightside up with the front toward you.

Remove the two Phillips PM2.5x6.0 screws (1) and loosen the Phillips PM2.5x11.0 captive screw
(2) that secure the hard drive to the computer.

Grasp the mylar tab on the hard drive and slide the hard drive (3) to the right to disconnect it
from the system board.
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4. Remove the hard drive (4) from the hard drive bay.

5. |Ifitis necessary to replace the hard drive bracket, remove the two Phillips PM3.0x4.0 hard drive
bracket screws (1) from each side of the hard drive.

6. Llift the bracket (2) straight up to remove it from the hard drive.

Reverse this procedure to reassemble and install the hard drive.
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Display assembly on computers with 17.3-in displays

Ef NOTE: The Miscellaneous LCD Cable Kit, spare part number 599806-001, includes 2 WLAN

antenna transceivers and cables.

Description Spare part number

17.3-in HD BrightView display assembly for use in computers equipped with webcam and WWAN  598708-001
(1600%900 resolution)

17.3-in HD BrightView display assembly (1600x900 resolution) 606167-001

17.3-in HD AntiGlare display assembly for use in computers equipped with webcam and WWAN  606166-001
(1600%900 resolution)

17.3-in HD BrightView display assembly (1600x900 resolution) 606165-001
17.3-in HD+ BrightView display assembly (1600x900 resolution) 599080-001
Display cable for use with HD+ displays 629030-001

Before removing the display assembly, follow these steps:

1.

2,
3.

4.
5.
6.
7.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 55).

Remove the switch cover and keyboard (see Switch cover and keyboard on page 56).

Disconnect the power button cable from the system board (see Power button board on page 63).

Remove the speakers (see Speakers on page 65).

Remove the display cables:

Position the computer rightside up with the front toward you.
Open the computer as far as possible.

Disconnect the webcam (1) and display panel cable (2) from the system board and from the
routing channels.

Disconnect the microphone cable (3) from the system board and from the routing channels.
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5. Disconnect and remove the WLAN wireless antenna cables (4) from the tape, clips, and routing
channels built into the top cover.

Remove the display assembly:

A CAUTION: Support the display assembly when removing the following screws. Failure to support the
display assembly can result in damage to the display assembly and other computer components.

1. Remove the six Torx M2.5%x6.0 screws (1) that secure the display assembly to the computer.
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2. Lift the display assembly (2) straight up.
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3. Ifitis necessary to replace the display bezel, display enclosure, or display hinges, remove the two
mylar screw covers (1) at the bottom corners of the display and the two Torx M2.0x6.0 screws

(2) that secure the display bezel to the display assembly.
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4. Flex the bottom bezel (1) around the hinge areas on the inside of the display enclosure and work

around the periphery of the bezel (2) and (3).
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5. When the bezel is free, lift it (4) from the display.

6. Ifitis necessary to replace the webcam module, gently pull the webcam module away from the
double-sided tape on the display enclosure (1) and disconnect the webcam cable from the module
(2).The webcam module with cable can be ordered by using spare part number 598671-001.

B NOTE: To replace the webcam module in the display enclosure, align the holes on the webcam
module with the pins on the display enclosure and press onto the double-sided tape.
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7. Ifitis necessary to replace the display hinges, remove the display panel by removing the two Torx
M2.0x6.0 screws (1) that secure the panel to the top of the display enclosure, and then remove
the four Torx M2.0x6.0 screws (2) located at the hinge arms. This will allow the panel to be lifted

from the enclosure.

8. Remove the eight Phillips PM2.0x3.0 screws (1) that secure the display hinges to the display
panel, and then remove the display hinges (2). The left and right display hinges are available in
the Display Hinge Kit, spare part number 602677-001 for computers with 17.3-in displays.

9. Ifitis necessary to replace the display cable, turn the display panel upside-down and remove the
microphone (1) and the microphone cable (2) from the cable routing area. then disconnect the
cable from the connector on the back of the display panel (2).
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10. Disconnect the display cable from the back of the display panel (3) and remove the webcam
cable (4) from the raceway. The display cable is spared in the LCD cable kit, spare part number
599806-001.

Reverse this procedure to reassemble and install the display assembly.
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Display assembly on computers with 15.6-in displays

Ef NOTE: For information about removing the display from 17.3-in models, see Display assembly on
computers with 17.3-in displays on page 89.

NOTE: The Miscellaneous LCD Cable Kit, spare part number 599806-001, includes 2 WLAN

antenna transceivers and cables.

Description Spare part number

For use only with computers with 15.6-in displays and black trim

e 15.4-in HD BrightView display assembly for use in computers equipped with webcam and 598707-001
WWAN (1366x768 resolution)

e 15.4-in HD BrightView display assembly for use in computers with webcam (1366x768 598706-001
resolution)

e 15.6-in HD BrightView display assembly (1366x768 resolution) 598705001

e  15.6-in HD BrightView LVDS display assembly (1366x768 resolution) 623182001

e 15.6-in HD AntiGlare display assembly for use in computers equipped with webcam and 598704-001
WWAN (1366x768 resolution)

e 15.6-in HD AntiGlare display assembly for use in computers equipped with webcam 598703-001
(1366x768 resolution)

e 15.6-in HD AntiGlare display assembly (1366x768 resolution) 598702-001

e  15.6-in HD SVA LVDS AntiGlare display assembly (1366x768 resolution) 624238001

e  15.6-in WVA LVDS HD AntiGlare display assembly (1366x768 resolution) 624643-001

For use only with computers with 15.6-in displays and red trim

®  15.6-in HD BrightView display assembly for use in computers with webcam and WWAN 604859-001
(1366x768 resolution)

e 15.6-in HD BrightView display assembly for use in computers with webcam (1366x768 604858-001
resolution)

®  15.6-in HD BrightView display assembly for use in computers (1366x768 resolution) 604857-001

®  15.6-in HD AntiGlare display assembly for use in computers equipped with webcam and 604856001

WWAN (1366x768 resolution)

®  15.6-in HD AntiGlare display assembly for use in computers equipped with webcam 604855001
(1366x768 resolution)

e 15.4in HD AntiGlare display assembly (1366x768 resolution) 604854-001

For use only with computers with 15.6-in displays and champagne-colored trim

e  15.6-in HD BrightView display assembly for use in computers with webcam and WWAN 626120001
(1366x768 resolution)

e  15.6-in HD BrightView display assembly for use in computers with webcam (1366x768 626119-001
resolution)

e 15.6-in HD BrightView display assembly (1366x768 resolution) 626118-001

e  15.6-in HD AntiGlare display assembly for use in computers equipped with webcam and 626117001

WWAN (1366x768 resolution)
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Description Spare part number

15.6-in HD AntiGlare display assembly for use in computers equipped with webcam 626116-001
(1366x768 resolution)

15.6-in HD AntiGlare display assembly (1366x768 resolution) 626115001

Before removing the 15.6-in display assembly, follow these steps:

1.

2,
3.

4.
5.
6.
7.
8.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 55).

Remove the switch cover and keyboard (see Switch cover and keyboard on page 56).

Disconnect the power button cable from the system board (see Power button board on page 63).

Remove the speakers (see Speakers on page 65)

Remove the thermal shield (see Thermal shield on page 67).

Remove the display cables:

Remove the tape that holds the cables in place(1). Disconnect the display and webcam cables
from the system board and from the routing channels.

Disconnect the cable connectors for the display (2) and microphone (3) from the system board.

Disconnect the WLAN and WWAN cables (4) from the tape and from the routing channels built

into the top cover.
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Remove the display assembly:
1. Position the computer rightside up with the front toward you.

2. Open the computer as far as possible.

A CAUTION: Support the display assembly when removing the retaining screws. Failure to
support the display assembly can result in damage to the display assembly and other computer
components.

3. Remove the six Torx M2.5x6.0 screws (1) that secure the display assembly to the computer.
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4. lift the display assembly up and off the computer (2).

5. |Ifitis necessary to replace the display bezel, display enclosure, or display hinges, remove the two
mylar screw covers (1) and the 2 Torx M2.5x6.0 screws (2) that secure the display bezel to the
display assembly. The screw covers are available in the Rubber Kit, spare part number

598678-001.

-0,
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6. Flex the bottom bezel (1) around the hinge areas on the inside of the display enclosure and work
around the periphery of the bezel (2) and (3).
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7. Llift the bezel (4) until it disengages completely.

8. Ifitis necessary to replace the webcam module, gently pull the webcam module away from the
double-sided tape on the display enclosure (1) and disconnect the webcam cable from the module
(2). The webcam module and cable can be ordered by using spare part number 598671-001.

B NOTE: To replace the webcam module in the display enclosure, align the holes on the webcam
module with the pins on the display enclosure and press onto the double-sided tape.

9. Ifitis necessary to replace the display hinges, remove the six Torx M2.5x5.0 screws (1) that
secure the hinges to the display housing.
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10. Remove the display panel from the housing (2).
T—\

ey

11. Remove the six Phillips PM2.0x3.0 screws (1) that secure the display hinges to the display panel,
and then remove the display hinges (2). The left and right display hinges are available in the
Hinge Kit, spare part number 598679-001 for computers with 15.6-in displays.

To replace the webcam, webcam cable, and display cable:

1. Remove the microphone from its socket (1) and lift its cable (2) from the raceway.
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2. Remove the webcam cable (3) from the raceway and then, remove the cable assembly (4).

& NOTE: The cables are attached to the display panel with adhesive tape.

®of
-

To remove the WLAN and WWAN antennas:
1. Peel the WLAN (1) and WWAN (2) antenna receivers from the housing.

2. Route the antenna cables (3) out of the routing channels in the inside of the display housing.

1
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Reverse this procedure to install the display assembly.
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Top cover

B NOTE: The top cover removal procedures differ for 17.3-in and 15.6-in computers.

Description Spare part number
Top cover for use in computers with 17.3-in displays 598683-001
Top cover for use in computers with 15.6-in displays 598682-001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 55).

5. Remove the switch cover and keyboard (see Switch cover and keyboard on page 56).

6. Remove the optical drive (see Optical drive on page 61).

7. Remove the power button board cable (see Power button board on page 63).

8. Remove the speakers (see Speakers on page 65).

9. Remove the thermal shield (seeThermal shield on page 67 ).

10. Remove the display assembly (see Display assembly on computers with 17.3-in displays
on page 89 or Display assembly on computers with 15.6-in displays on page 96).

11. Remove the palm rest (see Palm rest on page 84).

12. Remove the hard drive (see Hard drive on page 87).

13. Remove the following components:
Remove the top cover on 17.3-in computers:

1. Position the computer rightside up with the front toward you.
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2. Disconnect the power button board cable from the system board by releasing the ZIF connector
(1), and then disconnecting the cable (2).

3. Remove the 17 Torx M2.5x6.0 screws that secure the top cover to the computer.
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4. Remove the ExpressCard bezel (1), then angle the top cover up (2), and lift it up (3) until it
disengages from the base enclosure.

Remove the top cover on 15.6-in computers:
1. Position the computer rightside up with the front toward you.

2. Disconnect the power button board cable from the system board by releasing the ZIF connector
(1), and then disconnecting the cable (2).
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3. Remove the 10 Torx M2.5x6.0 screws that secure the top cover to the computer.

1
I
I
I
I
I
I

4. Remove the ExpressCard bezel (1), then angle the top cover up (2), and lift it up (3) until it
disengages from the base enclosure.

-

Reverse this procedure to install the top cover.
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RTC battery

Description Spare part number

RTC battery 616073-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 55).

5. Remove the switch cover and keyboard (see Switch cover and keyboard on page 56).

6. Remove the optical drive (see Optical drive on page 61).

7. Remove the power button board cable (see Power button board on page 63).

8. Remove the speakers (see Speakers on page 65).

9. Remove the thermal shield (see Thermal shield on page 67).

10. Remove the display assembly (see Display assembly on computers with 17.3-in displays
on page 89 or Display assembly on computers with 15.6-in displays on page 26).

11. Remove the palm rest (see Palm rest on page 84).

12. Remove the hard drive (see Hard drive on page 87).

13. Remove the top cover (see Top cover on page 103).

Remove the RTC battery:

1. Position the computer rightside up with the front toward you.
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2. Release the RTC battery from the socket (1) on the system board and lift the battery (2) up.

Reverse this procedure to install the RTC battery.
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Bluetooth module

B’ NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth
module cable is included in the Cable Kit, spare part number 599807-001. See Cable Kits on page 33
for more Cable Kit spare part number information.

Description Spare part number

HP Integrated Bluetooth 2.1 module for use in all countries and regions except Japan and Asia 537921-001
Pacific countries and regions

Before removing the Bluetooth module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 55).

5. Remove the switch cover and keyboard (see Switch cover and keyboard on page 56).

6. Remove the optical drive (see Optical drive on page 61).

7. Remove the power button board cable (see Power button board on page 63).

8. Remove the speakers (see Speakers on page 65).

9. Remove the thermal shield (see Thermal shield on page 67).

10. Remove the display assembly (see Display assembly on computers with 17.3-in displays
on page 89 or Display assembly on computers with 15.6-in displays on page 926).

11. Remove the palm rest (see Palm rest on page 84).

12. Remove the hard drive (see Hard drive on page 87).

13. Remove the top cover (see Top cover on page 103).

Remove the Bluetooth module:
1. Position the computer rightside up with the front toward you.

2. Disconnect the Bluetooth cable (1) from the system board and from the antenna (2).
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3. Remove the Bluetooth antenna (3) from the base enclosure.

V r;““ pr

Reverse this procedure to install the Bluetooth module.

Modem module

Description Spare part number
For use in all countries and regions except Australia and New Zealand 510100001
For use only in Australia and New Zealand 510100-011

Before removing the modem module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 55).

5. Remove the switch cover and keyboard (see Switch cover and keyboard on page 56).

6. Remove the optical drive (see Optical drive on page 61).
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7. Remove the power button board cable (see Power button board on page 63).

8. Remove the speakers (see Speakers on page 65).

9. Remove the thermal shield (see Thermal shield on page 67).

10. Remove the display assembly (see Display assembly on computers with 17.3-in displays
on page 89 or Display assembly on computers with 15.6-in displays on page 96).

11. Remove the palm rest (see Palm rest on page 84).

12. Remove the hard drive (see Hard drive on page 87).

13. Remove the top cover (see Top cover on page 103).

Remove the modem module:
1. Position the computer rightside up with the front toward you.

2. Remove the two Phillips PM2.5x3.0 screws (1) that secure the modem module to the system
board.

3. Lift the modem module (2) straight up from the system board.

4. Disconnect the modem module cable (3). The modem module cable is spared in the Cable kit
spare part number 599807-001.

5. Remove the modem module.

Reverse this procedure to install the modem module.
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Audio board

B NOTE: The spare part number for the audio board is 598684-001.

Before removing the audio board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 55).

5. Remove the switch cover and keyboard (see Switch cover and keyboard on page 56).

6. Remove the optical drive (see Optical drive on page 61).

7. Remove the power button board cable (see Power button board on page 63).

8. Remove the speakers (see Speakers on page 65).

9. Remove the thermal shield (see Thermal shield on page 67).

10. Remove the display assembly (see Display assembly on computers with 17.3-in displays
on page 89 or Display assembly on computers with 15.6-in displays on page 96).

11. Remove the palm rest (see Palm rest on page 84).

12. Remove the hard drive (see Hard drive on page 87).

13. Remove the top cover (see Top cover on page 103).

Remove the audio board:
1. Position the computer rightside up with the front toward you.
2. Remove the M2.5x3.0 screw (1) that secures the audio board to the system board.

3. Release the ZIF connector (2) and remove the cable (3).
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4. Remove the audio board (4) by pulling the module straight up and off the computer.

Reverse this procedure to install the audio board.
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System board

Ef NOTE: The system board spare part kit includes replacement thermal material.

Description Spare part number
System board with UMA graphics and RTC battery 598667-001
System board with UMA graphics, WWAN capability, and RTC battery 598669-001
System board with discrete graphics and RTC battery 598668-001

System board with discrete graphics, WWAN capability, and RTC battery for use in 4720s models  598670-001

System board with UMA graphics and RTC battery for use only in the People's Republic of China 605168001
and Russia

System board with UMA graphics, WWAN capability, and RTC battery for use only in the People's  605170-001
Republic of China and Russia

System board with discrete graphics and RTC battery for use only in the People's Republic of China  605169-001

and Russia

System board with discrete graphics, WWAN capability, and RTC battery for use only in the 605171-001
People's Republic of China and Russia

System board with ATl Mobility Radeon HD 5470 graphics for use in 4720s models 628794-001
System board with ATl Mobility Radeon HD 5470 graphics for use in 4520s models 628795001

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

bl

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 55).

Remove the switch cover and keyboard (see Switch cover and keyboard on page 56).

Remove the optical drive (see Optical drive on page 61).

Remove the power button board cable (see Power button board on page 63).

Remove the speakers (see Speakers on page 65).

© ©® N o u »

. Remove the thermal shield (see Thermal shield on page 67).

-
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Remove the display assembly (see Display assembly on computers with 17.3-in displays
on page 89 or Display assembly on computers with 15.6-in displays on page 96).

11. Remove the palm rest (see Palm rest on page 84).
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12. Remove the hard drive (see Hard drive on page 87).

13. Remove the top cover (see Top cover on page 103).

When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:

®  Memory module (see Memory module on page 60)

e WILAN module (see WLAN module on page 70)

*  WWAN module (see WWAN module on page 76)

®  Modem module (see Modem module on page 110)

®  Processor (see Processor on page 83)

e Audio board (see Audio board on page 112)

Remove the system board:
1. Position the computer rightside up with the front toward you.
2. Remove the M2.0x3.0 screw on the left of the system board (1).

3. [fthisis a 17.3-in computer, remove the single M2.0 x 3.0 screw (2) that secures the optical drive
connector to the base.

B NOTE: The 15.6-in computer does not use a separate optical drive connector.

4. lift the board at an angle (3) and remove the optical drive extender (4).

5. Slide the board partially out of the base pan (5).

7
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6. Disconnect the power cable (1) from the system board and the connector (2) from the computer.
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8. Remove the screw (1) that secures the USB to the computer, disconnect the cable (2) from the
system board and then, remove the device (3) from the computer.

Reverse this procedure fo install the system board.

USB connector assembly

Ef NOTE: The USB connector assembly is included in the Cable Kit, spare part number 603188-001 for
computers with 17.3-in displays and in 599807-001 for computers with 15.6-in displays.

Before removing the USB connector assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 55).

5. Remove the switch cover and keyboard (see Switch cover and keyboard on page 56).

6. Remove the optical drive (see Optical drive on page 61).

7. Remove the power button board cable (see Power button board on page 63).

8. Remove the speakers (see Speakers on page 65).
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9. Remove the thermal shield (see Thermal shield on page 67).

10. Remove the display assembly (see Display assembly on computers with 17.3-in displays
on page 89 or Display assembly on computers with 15.6-in displays on page 96).

11. Remove the palm rest (see Palm rest on page 84).

12. Remove the hard drive (see Hard drive on page 87).

13. Remove the top cover (see Top cover on page 103).

Remove the USB connector assembly:
1. Position the computer right-side up with the right side toward you.

2. Remove the Phillips PM2.5x3.0 screw (1) that secures the USB connector assembly to the base
enclosure.

3. Disconnect the cable from the system board (2).

4. Remove the USB connector assembly (3) from the base enclosure.

Reverse this procedure to install the USB connector assembly.
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RJ-11 connector assembly

Ef NOTE: The RJ-11 connector assembly is included in the Base Cable Kit, spare part number
603188-001 for 17.3-in computers and 599807-001 for 15.6-in computers.

Before removing the RJ-11 connector assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 55).

5. Remove the switch cover and keyboard (see Switch cover and keyboard on page 56).

6. Remove the optical drive (see Optical drive on page 61).

7. Remove the power button board cable (see Power button board on page 63).

8. Remove the speakers (see Speakers on page 65).

9. Remove the thermal shield (see Thermal shield on page 67).

10. Remove the display assembly (see Display assembly on computers with 17.3-in displays
on page 89 or Display assembly on computers with 15.6-in displays on page 96).

11. Remove the palm rest (see Palm rest on page 84).

12. Remove the hard drive (see Hard drive on page 87).

13. Remove the top cover (see Top cover on page 103).

Remove the RJ-11 connector assembly:
1. Position the computer rightside up with the right side toward you.

2. Disconnect the cable from the system board (1) and remove the cable from the routing channel in
the base enclosure.
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3.

Lift the R-11 connector (2) from its holder and out of the base enclosure.

Reverse this procedure to install the RJ-11 connector assembly.

Power connector assembly

Ef NOTE: The power connector assembly is included in the Base Cable Kit, spare part number
603188-0001 for computers with 17.3-in displays and 599807-001 for computers with 15.6-in

displays.

Before removing the power connector assembly, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 55).

Remove the following components:

a.
b.
c.

d.

Switch cover and keyboard (see Switch cover and keyboard on page 56)

Optical drive (see Optical drive on page 61)

Power button board cable (see Power button board on page 63)

Speakers (see Speakers on page 65)
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e. Thermal shield (see Thermal shield on page 67)

f. Display assembly (see Display assembly on computers with 17.3-in displays on page 89 or
Display assembly on computers with 15.6-in displays on page 96)

Palm rest (see Palm rest on page 84)

Hard drive (see Hard drive on page 87)

i. Top cover (see Top cover on page 103)

Remove the power connector assembly:
1. Position the computer rightside up with the right side toward you.

2. Disconnect the cable from the system board (1) and remove the tape and cable from the routing
channel in the base enclosure.

3. Lift the power connector (2) from the base enclosure.

Reverse this procedure to install the power connector.
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5 Computer Setup

Computer Setup

Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system
is not working or will not load.

Ef NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer or your operating system.

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

4

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu’
message is displayed at the bottom of the screen.

2. Press {10 to enter BIOS Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, and System
Configuration menus.

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

e To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press entfer, or use a pointing device to click the item.

e To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

e  To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.
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B NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.
3. Select the File, Security, or System Configuration menu.
To exit Computer Setup menus, choose one of the following methods:

®  To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

—or —

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

® To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

—or —

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

Ef NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

Press f10 to enter BIOS Setup.
Use a pointing device or the arrow keys to select File > Restore Defaults.

Follow the on-screen instructions.

o ~r O DN

To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

B’ NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus

The menu tables in this section provide an overview of Computer Setup options.

B NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by your
computer or your operating system.

File menu

Select To do this

System Information e View identification information for the computer and the

batteries in the system.
e View specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.
Set System Date and Time Set or change the date and time on the computer.
System Diagnostics Displays the following information:
e  System information
> |dentification information for the computer and the
batteries in the system.

> Specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

e  Start-up Test—Verifies the system components needed for
starting the computer.

®  Run-in Test—Runs a comprehensive check on system
memory.

e Hard Disk Test—Runs a comprehensive selftest on any
hard drive in the system.

®  Memory Test—Runs a comprehensive test on any
memory installed in the computer.

e  Battery Test—Runs a comprehensive test on any batteries
installed in the computer.

Error Log—Displays a log file if any errors have
occurred.

Restore Defaults Replace the configuration settings in Computer Setup with the
original factory settings. (Hard drive mode, password settings,
and security settings are not changed when you restore the
factory settings.)

Reset BIOS security to factory default Restore the BIOS security settings to the factory default.
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Select To do this

Ignore Changes and Exit Cancel any changes entered during the current session. Then
exit and restart the computer.

Save Changes and Exit Save any changes entered during the current session. Then
exit and restart the computer. Your changes go into effect
when the computer restarts.
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Security menu

B NOTE: Some of the menu items listed in this section may not be supported by your computer or your

operating system.

Select

To do this

Setup BIOS Administrator Password

Set up a BIOS administrator password.

User Management > Create a New BIOS User Account
(requires a BIOS administrator password)

e Select from a list of BIOS users.

e Select from a list of ProtectTools users.

Password Policy (requires a BIOS administrator password)

Revise password policy criteria.

HP SpareKey

Enable/disable HP SpareKey (disabled by default).

Fingerprint Reset on Reboot (If Present)

Reset/clear the fingerprint reader ownership (select models
only; disabled by default).

Change Password

Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment

Enroll or reset HP SpareKey, which is a set of security
questions and answers used if you forget your password.

Anti Theft > AT-p (select models only)

Enable/disable Anti-theft Protection.

Drivelock Password

e  Enable/disable Drivelock on any computer hard drive

(enabled by default).
e Change a Drivelock user password or master password.

NOTE: Drivelock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.

Automatic Drivelock

Enable/disable Automatic Drivelock support (disabled by
default).

Disk Sanitizer

Run Disk Sanitizer to destroy all existing data on the primary
hard drive or the drive in the upgrade bay.

CAUTION: If you run Disk Sanitizer, the data on the
selected drive is destroyed permanently.

System IDs

Enter a user-defined computer asset tracking number and
ownership tag.
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System Configuration menu

B NOTE: Some of the listed System Configuration options may not be supported by your computer or
your operating system.

Select To do this
Language Change the Computer Setup language.
Boot Options e  Seta startup menu delay (in seconds).

e Set the MultiBoot Express Boot Popup delay in seconds.
e  Enable/disable custom logo (disabled by default).

e  Enable/disable display diagnostic URL (enabled by
default).

e Enable/disable CD-ROM boot (enabled by default).
e  Enable/disable SD card boot (enabled by default).
e  Enable/disable floppy boot (enabled by default).

e Enable/disable PXE internal NIC boot (enabled by
default).

e Enable/Disable Unified Extensible Firmware Interface

(UEFI) Boot Mode (disabled by default).

e Set the legacy boot order.
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Select

To do this

Device Configurations

Enable/disable USB legacy support (enabled by defaul).
When enabled, USB legacy support allows the following:

> Use of a USB keyboard in Computer Setup even
when a Windows operating system is not running.

> Startup from bootable USB devices, including a
hard drive, diskette drive, or optical drive
connected by a USB port to the computer.

Select a parallel port mode: ECP (Enhanced Capabilities
Port), standard, bidirectional, or EPP (Enhanced Parallel
Port).

Enable/disable fan always on while connected to an AC
outlet (enabled by default).

Enable/disable Data Execution Prevention (select models
only). When enabled, the processor can disable some
virus code execution, which helps to improve computer
security (enabled by default).

Select a SATA (Serial Advanced Technology Attachment)
device mode. The following options are available:

> AHCI (Advanced Host Controller Interface)
> IDE (Integrated Drive Electronics)

> RAID (Redundant Array of Independent Disks) (select
models only)
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Select

To do this

NOTE: Availability of these options above varies by
computer model.

e  Enable/disable secondary battery fast charge (enabled
by default).

e  Enable/disable HP Quicklook 2 (enabled by default).

e  Enable/disable preboot authentication on HP Quicklock
boot (enabled by default).

e  Enable/disable HP QuickWeb (enabled by default).

e  Enable/disable HP QuickWeb write protect (disabled by
default).

e Enable/disable virtualization technology (select models
only; disabled by default).

e Enable/disable Intel TXT (Trust Execution Technology)
(select models only; disabled by default).

e Enable/disable Multi Core CPU (enabled by default).
e  Enable/disable Intel HT technology (enabled by default).
e  Enable/disable wake on USB (enabled by default).

e Enable/disable Num lock state at boot (disabled by
default).
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Select To do this

Built-In Device Options e  Enable/disable the wireless button state (enabled by
default).

e  Enable/disable embedded WWAN device (select
models only; enabled by default).

®  Enable/disable embedded WLAN device (enabled by
default).

®  Enable/disable embedded Bluetooth device (enabled by
default).

®  Enable/disable the network interface controller (LAN)

(enabled by default).

e Enable/disable LAN/WLAN switching (disabled by
default).

e  Set the wake on LAN state. Options include the
following:

> Disabled
Boot to Network (default setting)
> Follow Boot Order

e  Enable/disable the ambient light sensor (enabled by
default).

®  Enable/disable the notebook upgrade bay device
(enabled by default).

®  Enable/disable the fingerprint device (enabled by
default).

e  Enable/disable the integrated camera (enabled by
default).

e  Enable/disable the power monitor circuit (enabled by

default).
e  Enable/disable the audio device (enabled by default).
e Enable/disable a modem device (enabled by default).
e  Enable/disable the microphone (enabled by default).

e  Enable/disable the internal speakers (enabled by
default).
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Select To do this

Port Options NOTE: All port options are enabled by default.
e Enable/disable the serial port (select models only).
e Enable/disable the parallel port (select models only).
e  Enable/disable the flash media reader.
e Enable/disable the USB port.

CAUTION: Disabling the USB port also disables
MultiBay devices and ExpressCard devices on the
advanced port replicator.

e Enable/disable the 1394 port (select models only).

e Enable/disable the ExpressCard slot (select models only).

Enable/disable the eSATA port (select models only).

AMT Options (select models only) NOTE: All AMT options are disabled by default.
e  Enable/disable firmware verbosity.
e  Enable/disable AMT setup prompt (Ctrl-P)
e  Enable/disable USB key provisioning support.
e  Enable/disable unconfigure AMT on next boot.

e Select terminal emulation mode. Options include the
following:

o ANSI (default setting)
° VT100

e  Enable/disable firmware progress event support.

Enable/disable initiate Intel CIRA.

Set Security Level Change, view, or hide security levels for all BIOS menu items.

Restore Security Defaults Restore the default security seftings.
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6 Specifications

Computer specifications

Metric u.s.
Dimensions - 15.6-in
Depth 24.96 cm 9.83 in
Width 37.18 cm 14.6 in
Height (front to rear) 2.77 to 3.55 cm 1.09to 1.40 in
Dimensions - 17.3-in
Depth 26.64 cm 10.49 in
Width 41.60 cm 16.17 in
Height (front to rear) 2.82 to 3.60 cm 1.11t0 1.48 in
Weight - 15.6-in (equipped with optical drive, WXGA < 2.5 kg <5.5lbs
display assembly, 1 memory module, hard drive, and é-cell
battery)
Weight - 17.3-in (equipped with optical drive, WXGA < 3.1kg < 6.8 |bs
display assembly, 1 memory module, hard drive, and é-cell
battery)
Input power
Operating voltage 18.5Vdc@4.74 A-90 W
Operating current 4.74 A
Temperature
Operating (not writing fo optical disc) 0°C to 35°C 32°F to 95°F
Operating (writing to optical disc) 5°C to 35°C 41°F to 95°F
Nonoperating -20°C to 60°C -4°F to 140°F
Relative humidity
Operating 10% to 90%
Nonoperating 5% to 95%

Maximum altitude (unpressurized)
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Metric u.s.

Operating -15mto 3,048 m -50 ft to 10,000 ft
Nonoperating -15mto 12,192 m -50 ft to 40,000 ft
Shock

Operating 125 g, 2 ms, halfsine

Nonoperating 200 g, 2 ms, halfsine

Random vibration

Operating 0.75 g zero+o-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep
rate

Nonoperating 1.50 g zero+to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep
rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this
range of temperatures.

17.3-in display specifications

Metric u.s.
Dimensions
Height 23.334 cm 9.2in
Width 39.86 cm 15.7 in
Diagonal 43.94 cm 17.3in
Number of colors Up to 16.8 million
Contrast ratio 500:1 (typical BrightView), 300:1 (typical AntiGlare)
Brightness 200 nits (typical)
Pixel resolution
Format 1600 x 900
Configuration RGB
Backlight LED
Response Time 16 ms
Total power consumption 5.3 W (max)
Viewing angle @CR>10 5 VA
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15.6-in display specifications

Metric u.s.
Dimensions
Height 21.0 cm 8.3in
Width 35.98 cm 14.2 in
Diagonal 39.1 cm 15.6in
Number of colors Up to 16.8 million
Contrast ratio 500:1 (min BrightView), 300:1 (min AntiGlare))
Brightness 200 nits (typical)
Pixel resolution
Format 1366 x 768
Configuration RGB
Backlight LED
Response Time 8 ms (typ)
Total power consumption 4.1 W (max)
Viewing angle @ CR>10 SVA
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Hard drive specifications

750-GB* 640-GB* 500-GB* 320-GB* 250-GB*
Dimensions
Height 9.5 mm 9.5 mm 9.5 mm 9.5 mm 9.5 mm
Width 70 mm 70 mm 70 mm 70 mm 70 mm
Weight 101g 101g 101g 101g 101g
Interface type SATA SATA SATA SATA SATA
Transfer rate 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec
Security ATA security ATA security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 2 ms 2 ms 3 ms 3 ms 3 ms

Average 12 ms 12 ms 13 ms 13 ms 13 ms

Maximum 22 ms 22 ms 24 ms 24 ms 24 ms

Logical blocks 1,465,452,80 1,250,263,72 1,048,576,00 625,141,400 488,376,280

6 8 0

Disc rotational speed 5400 rpm 5400 rpm 5400 rpm 5400 rpm 7200 rpm

Operating temperature 5°Cto 55°C 5°Cto 55°C 5°Cto 55°C 5°Cto 55°C 5°Cto 55°C
(41°F to (41°Fto 131°F) (41°F 1o (41°Fto 131°F)  (41°Fto 131°F)
131°F) 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.

NOTE: Cerlain restrictions and exclusions apply. Contact technical support for details.
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DVD-ROM Drive specifications

Applicable disc DVD-ROM (DVD-5, DVD-9, DVD-10, DVD-18, CD-ROM (Mode 1 and 2), CD Digital Audio,
CD-XA ready (Mode 2, Form 1 and Form 2), CD-l (Mode 2, Form 1 and Form 2), CD-R,
CD-RW, Photo CD (single and multisession), CD-Bridge

Access time CcD DVD
Random < 100 ms <125 ms
Cache buffer 512 KB

Data transfer rate

CD-R (24X) 3600 KB/s (150 KB/s at 1X CD rate)
CD-RW (10X) 1500 KB/s (150 KB/s at 1X CD rate)
CD-ROM (24X) 3600 KB/s (150 KB/s at 1X CD rate)

DVD (8X) 10,800 KB/s (1,352 KB/s at 1X DVD rate)
Multiword DMA mode 2 16.6 MB/s
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DVD+RW Double-Layer Combo Drive specifications

Applicable disc Read: Write:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-ROM, CD-R and CD-RW

CD-ROM XA, MIXED MODE CD, CD-l, CD-l

Bridge (Photo-CD, Video CD), Multisession CD DVD+R, DVD+RW, DVDR, DVD-
(Photo-CD, CD-EXTRA, Portfolio, CDR, CD-RW), ~ RW, DVD-RAM

CD-R, CDRW, DVD-ROM (DVD-5, DVD-9,

DVD-10, DVD-18), DVDR, DVDRW, DVD+R,

DVD+RW, DVD-RAM

Access time CcD DVD
Random <175 ms <230 ms
Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec
8X DVD-ROM 10,800 KB/sec
24X CDR 3,600 KB/sec
16X CD-RW 2,400 KB/sec
8X DVD+R 10,800 KB/sec
4X DVD+RW 5,400 KB/sec
8X DVD-R 10,800 KB/sec
4X DVD-RW 5,400 KB/sec
2.4X DVD+R(9) 2,700 KB/sec
5X DVD-RAM 6,750 KB/sec

Transfer mode

Multiword DMA Mode
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Blu-ray Disc ROM Drive with SuperMulti DVD+R/RW
Double-Layer specifications

Applicable disc

Read:

Write:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT,
CD-ROM, CDROM XA,

MIXED MODE CD, CD-, CD Bridge
(Photo-CD, Video CD), Multisession CD
(Photo-CD, CD-EXTRA, Portfolio, CDR,
CD-RW), CD-R, CD-RW, DVD-

ROM (DVD-5, DVD-9, DVD-10,
DVD-18), DVDR, DVDRW, DVD+R,
DVD+RW, DVD-RAM, HD-

ROM (Single Layer), HD-ROM (Dual
Layer), HD DVD-R, HD DVD-R for

Dual Layer, HD DVDRW, BD-ROM, BD-

CD-R and CD-RW DVD+R, DVD+R (9),
DVD+RW, DVDR, DVDR (9), DVD-RW,
DVD-RAM

R, BRRE
Access time cD DVD HD
Random 170 ms 170 ms 230 ms
Cache buffer 8 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec
8X DVD-ROM 10,800 KB/sec
24X CDR 3,600 KB/sec
16X CD-RW 2,400 KB/sec
8X DVD+R 10,800 KB/sec
4X DVD+RW 5,400 KB/sec
8X DVDR 10,800 KB/sec
4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9)

2,700 KB/sec

5X DVD-RAM 6,750 KB/sec
1X BD-ROM 4,500 KB/sec
1X BD-R read 4,500 KB/sec

1X BD-RE read

4,500 KB/sec

Transfer mode

Multiword DMA Mode
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7

Backup and recovery

Backup and recovery in Windows 7

Overview

To protect your information, use the Backup and Restore Center to back up individual files and folders,
back up your entire hard drive (select models only), or create system restore points. In case of system
failure, you can use the backup files to restore the contents of your computer.

The Backup and Restore Center provides the following options:
e  Creating a system repair disc (select models only)

e  Backing up individual files and folders

e Backing up a system image (select models only)

e Scheduling automatic backups (select models only)

e  Creating system restore points

®  Recovering individual files

®  Restoring the computer to a previous state

®  Recovering information using recovery tools

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and save
them for later use.

Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create system
repair discs (select models only) and your initial backup immediately after software setup. As you add
new software and data files, you should continue to back up your system on a regular basis to maintain
a reasonably current backup. The system repair discs (select models only) are used to start up (boot) the
computer and repair the operating system in case of system instability or failure. Your initial and
subsequent backups allow you to restore your data and settings if a failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.
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Note the following when backing up:
e Store personal files in the Documents folder, and back it up regularly.
e Back up templates that are stored in their associated programs.

e  Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a screen shot:

1. Display the screen you want fo save.

2. Copy the screen image:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.
The screen image is added to the document.

4. Save the document.

®  When backing up to discs, use any of the following types of discs (purchased separately): CDR,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD+RW. The discs you use will depend on the

type of optical drive installed in your computer.

& NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

®  When backing up to discs, number each disc before inserting it into the optical drive of the
computer.

To create a backup using Backup and Restore Center, follow these steps:

Ef NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create a system repair disc (select models only).

Ef NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.
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Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

®  Windows recovery tools: You can use the Backup and Restore Center to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

e {11 recovery tools: You can use the {11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.

B NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair discs
you previously created (select models only), you must purchase a Windows 7 operating system DVD to
reboot the computer and repair the operating system. For additional information, refer to the “Using a
Windows 7 operating system DVD (purchased separately)” section in this guide.

Using the Windows recovery tools
To recover information you previously backed up, follow these steps:
1. Click Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to recover your entire computer (select models only) or your files.

B NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support for more information.

To recover your information using Startup Repair, follow these steps:

A CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard drive.
All files you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. |If possible, check for the presence of the Windows partition and the HP Recovery partition.

Ef NOTE: If the Windows partition and the HP Recovery partition have been deleted, you must
recover your operating system and programs using the Windows 7 operating system DVD and the
Driver Recovery disc (both purchased separately). For additional information, refer to the “Using a
Windows 7 operating system DVD (purchased separately)” section in this guide.

3. If the Windows partition and the HP Recovery partition are listed, restart the computer, and then
press {8 before the Windows operating system loads.

4. Select Repair your computer.

5. Follow the on-screen instructions.

B NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.
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Using 11

A CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The {11
recovery fool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11, follow these steps:
1. |If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition. To find the partition, select Start
> Computer.

B NOTE: If the HP Recovery partition has been deleted, you must recover your operating system
and programs using the Windows 7 operating system DVD and the Driver Recovery disc (both
purchased separately). For additional information, refer to the “Using a Windows 7 operating
system DVD (purchased separately)” section in this guide.

3. If the hP Recovery partition is listed, restart the computer, and then press esc while the “Press the
ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press {11 to enter HP Recovery.

5. Follow the on-screen instructions.

Using a Windows 7 operating system DVD (purchased separately)

If you are unable to boot (start up) your computer and you cannot use the system repair discs you
previously created (select models only) , you must purchase a Windows 7 operating system DVD to
reboot the computer and repair the operating system. Make sure that your most recent backup (stored
on discs or on an external drive) is easily accessible. To order a Windows 7 operating system DVD, go
to http://www.hp.com/support, select your country or region, and follow the on-screen instructions.
You can also order the DVD by calling technical support. For contact information, refer to the
Worldwide Telephone Numbers booklet included with the computer.

A CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 7 operating system DVD, follow these steps:

B NOTE: This process takes several minutes.

1. |If possible, back up all personal files.

2. Restart the computer, and then insert the Windows Vista operating system DVD into the optical
drive before the Windows operating system loads.

3.  When prompted, press any keyboard key.
4. Follow the on-screen instructions.

5. Click Next.
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6. Select Repair your computer.

7. Follow the on-screen instructions.

Backup and recovery in Windows Vista

Overview

To protect your information, use the Backup and Restore Center to back up individual files and folders,
back up your entire hard drive (select models only), or create system restore points. In case of system
failure, you can use the backup files to restore the contents of your computer.

The Backup and Restore Center provides the following options:
e  Backing up individual files and folders

®  Backing up the entire hard drive (select models only)

e  Scheduling automatic backups (select models only)

e  Creating system restore points

®  Recovering individual files

®  Restoring the computer to a previous state

®  Recovering information using recovery tools

B NOTE: For detfailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and save
them for later use.

Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

You can back up your information to an optional external hard drive, a network drive, or discs.
Note the following when backing up:

®  Store personal files in the Documents folder, and back it up regularly.

®  Back up templates that are stored in their associated programs.

®  Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.
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To create a screen shot:

1. Display the screen you want fo save.

2. Copy the screen image:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.
The screen image is added to the document.

4. Save the document.

®  When backing up to discs, use any of the following types of discs (purchased separately): CDR,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD+RW. The discs you use will depend on the

type of optical drive installed in your computer.

& NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

®  When backing up to discs, number each disc before inserting it into the optical drive of the
computer.

To create a backup using Backup and Restore Center, follow these steps:

Ef NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to back up your entire computer (select models only) or your files.

Ef NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

®  Windows recovery tools: You can use the Backup and Restore Center to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

e {11 recovery tools: You can use the {11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.
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Ef NOTE: If you are unable to boot (start up) your computer, you must purchase a Windows Vista®
operating system DVD to reboot the computer and repair the operating system. For additional
information, refer to the “Using a Windows Vista operating system DVD (purchased separately)
section in this guide.

”n

Using the Windows recovery tools
To recover information you previously backed up, follow these steps:
1. Click Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to recover your entire computer (select models only) or your files.

Ef NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support for more information.

To recover your information using Startup Repair, follow these steps:

A CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard drive.
Al files you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.

1. |If possible, back up all personal files.

2. |If possible, check for the presence of the Windows partition and the HP Recovery partition. To find
the partitions, select Start > Computer.

B NOTE: If the Windows partition and the HP Recovery partition have been deleted, you must
recover your operating system and programs using the Windows Vista operating system DVD and
the Driver Recovery disc (both purchased separately). For additional information, refer to the
“Using a Windows Vista operating system DVD (purchased separately)” section in this guide.

3. Restart the computer, and then press {8 before the Windows operating system loads.
4. Select Repair your computer.

5. Follow the on-screen instructions.

B NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.

Using f11

A CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The {11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled.
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To recover the original hard drive image using f11, follow these steps:
1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition. To find the partition, select Start
> Computer.

B NOTE: If the HP Recovery partition has been deleted, you must recover your operating system
and programs using the Windows Vista operating system DVD and the Driver Recovery disc (both
purchased separately). For additional information, refer to the “Using a Windows Vista operating
system DVD (purchased separately)” section in this guide.

3. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

4. Pressfl1 to enter HP Recovery.

5. Follow the on-screen instructions.

Using a Windows Vista operating system DVD (purchased
separately)

If you are unable to boot (start up) your computer, you must purchase a Windows Vista operating
system DVD to reboot the computer and repair the operating system. Make sure that your most recent
backup (stored on discs or on an external drive) is easily accessible. To order a Windows Vista
operating system DVD, go to http://www.hp.com/support, select your country or region, and follow
the on-screen instructions. You can also order the DVD by calling technical support. For contact
information, refer to the Worldwide Telephone Numbers booklet included with the computer.

A CAUTION: Using a Windows Vista operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows Vista operating system DVD, follow these steps:

B NOTE: This process takes several minutes.

1. |If possible, back up all personal files.

2. Restart the computer, and then insert the Windows Vista operating system DVD into the optical
drive before the Windows operating system loads.

When prompted, press any keyboard key.
Follow the on-screen instructions.
Click Next.

Select Repair your computer.

A T o

Follow the on-screen instructions.
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Backup and recovery in Windows XP

Overview

To protect your information, use the Windows® Backup utility (select models only) to back up files and
folders or create recovery points. In case of system failure, you can use the backup files to restore your
computer.

Windows provides the following options:

e  Backing up individual files and folders
®  Backing up all files and folders

e  Scheduling automatic backups

e  Creating recovery points

®  Recovering information

B NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and save
them for later use.

Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

You can back up individual files or folders to an optional external hard drive or to a network drive.
Note the following when backing up:

®  Store personal files in the My Documents folder, and back it up periodically.

®  Back up templates stored in their associated programs.

e  Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it info a word-processing document:
a. Display the screen you want fo save.
b. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

c. Open a word-processing document, click Edit > Paste.
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The screen image is added to the document.
d. Save the document.

To create a backup using the Windows Backup utility (select models only), follow these steps:

Ef NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Click Start > All Programs > Accessories > System Tools > Backup.

2. Follow the on-screen instructions.

Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

e Windows recovery tools (select models only): You can use the Windows Backup utility to recover
information you have previously backed up.

e  Operating System and Driver Recovery discs (included with your computer): You can use the discs
fo recover your operating system and programs installed at the factory.

Recovering your information
To recover information you previously backed up, follow these steps:
1. |If possible, back up all personal files.
2. Click Start > All Programs > Accessories > System Tools > Backup.
The Backup or Restore Wizard opens.
3. Click Restore files and settings, and then click Next.

4. Follow the on-screen instructions.

B NOTE: For additional information on initiating a recovery in Windows, perform a search for this
topic in Help and Support.

Recovering the operating system and programs

A CAUTION: The recovery process reformats and completely erases the hard drive. All files you have
created and any software installed on the computer are permanently removed. The recovery process
reinstalls the original operating system, software, and drivers. Software, drivers, and updates not
installed by HP must be manually reinstalled.

To recover your operating system and programs, follow these steps:
1. |If possible, back up all personal files.
2. Insert the Operating System disc into the optical drive.

3. Shut down the computer.
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Turn on the computer.
Follow the on-screen instructions to install the operating system.

After the operating system is installed, remove the Operating System disc and insert the Driver
Recovery disc.

Follow the on-screen instructions to install the drivers and programs.
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8 Connector pin assignments

Audio-in (microphone)

Pin Signal
1 Audio signal in
2 Audio signal in
3 Ground

Audio-out (headphone)

1 2 3
Pin Signal
1 Audio out, left channel
2 Audio out, right channel
3 Ground

150 Chapter 8 Connector pin assignments



External monitor

@ OO0 ®
®000 W
©O000®G

Pin Signal

1 Red analog

2 Green analog
3 Blue analog

4 Not connected
5 Ground

6 Ground analog
7 Ground analog
8 Ground analog
9 +5 VDC

10 Ground

11 Monitor detect
12 DDC 2B data
13 Horizontal sync
14 Vertical sync
15 DDC 2B clock
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HDMI

1917151311 9 7 5 3 1

Coooooooo

1816 1412 10 8 & 4 2

Pin Signal

1 Transition minimized differential signal (TMDS) data 2+
2 TMDS data 2 shield

3 TMDS data 2-

4 TMDS data 1+

5 TMDS data 1 shield

6 TMDS data 1-

7 TMDS data O+

8 TMDS data O shield

9 TMDS data O-

10 TMDS clock+

11 TMDS clock shield

12 TMDS clock-

13 Consumer electronic control (CEC)
14 Not connected

15 DDC clock

16 DDC data

17 Ground

18 +5V power

19 Hot plug detect

152 Chapter 8 Connector pin assignments



RJ-11 (modem)

i

123456
Pin Signal
1 Unused
2 Tip
3 Ring
4 Unused
5 Unused
6 Unused
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RJ-45 (network)

LTI
12345678
i B

Pin Signal
1 Transmit +
2 Transmit -
3 Receive +
4 Unused
5 Unused
6 Receive -
7 Unused
8 Unused

Universal Serial Bus

1 2 3 4
I-_-_-_-.I

Pin Signal
1 +5 VDC
2 Data -
3 Data +
4 Ground

154 Chapter 8 Connector pin assignments



9 Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries and regions
The requirements listed below are applicable to all countries and regions:
e The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ).

e All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

®  The power cord sefs must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

e The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions

Country/region Accredited agency Applicable note number
Australia EANSW 1
Austria OVE 1
Belgium CEBC 1
Canada CSA 2
Denmark DEMKO 1
Finland FIMKO 1
France UTE 1
Germany VDE 1
ltaly IMQ 1
Japan METI 3
The Netherlands KEMA 1
Norway NEMKO 1
The People's Republic of China Cccc 5
South Korea EK 4
Sweden SEMKO 1
Switzerland SEV 1
Taiwan BSMI 4
The United Kingdom BSI 1
The United States uL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm? conductor size. The wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm?2 conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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10 Recycling

Battery

When a battery has reached the end of its useful life, do not dispose of the battery in general
household waste. Follow the local laws and regulations in your area for computer battery disposal.

Display

/A WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

A CAUTION: The procedures in this chapter can result in damage to display components. The only
components infended for recycling purposes are the liquid crystal display (LCD) panel and the
backlight. When you remove these components, handle them carefully.

Ef NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display
assembly that might require special handling at end-of-life. Disposal of mercury may be regulated
because of environmental considerations. For disposal or recycling information, contact your local
authorities, or see the Electronic Industries Alliance (EIA) Web site at http://www.eice.org.

This section provides disassembly instructions for the display assembly. The display assembly must be
disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

99—

B’ NOTE: The procedures provided in this chapter are general disassembly instructions. Specific details,
such as screw sizes, quantities, and locations, and component shapes and sizes, can vary from one
computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display assembly.

2. lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of
the display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel (3).
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4. Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

7. Turn the display panel assembly upside-down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display
panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

—0

F

13. Remove the backlight cover.

14. Turn the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside-down.

/A WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

17. Remove the backlight frame from the display panel.
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18. Remove the backlight from the backlight frame.

19. Disconnect the display panel cable (1) from the LCD panel.
20. Remove the screws (2) that secure the LCD panel to the display rear panel.
21. Release the LCD panel (3) from the display rear panel.

22. Release the tape (4) that secures the LCD panel to the display rear panel.

24. Recycle the LCD panel and backlight.
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Index

A
AC adapter
identifying 19
spare part numbers 36
AC adapter light, identifying 15
AMT options
AMT setup prompt (Cirl-P) 131
firmware progress event
support. 131
firmware verbosity 131
initiate Intel CIRA 131
termiinal emulation mode 131
unconfigure AMT on next
boot 131
USB key provisioning
support 131
antenna, disconnecting 74, 76
applications key, Windows 13
audio board
removal 112
spare part number 23, 112
audio, product description 4
audio-in (microphone) jack
identifying 14
pin assignments 150
audio-out (headphone) jack
identifying 14
pin assignments 150

B

backing up
Windows 7 139
Windows Vista 143
Windows XP 147

Backup and Restore

Center 139, 140, 143, 144

Base Cable Kit
contents 33
spare part number 33

base enclosure, spare part
number 29
battery
identifying 19
removal 55
spare part number 29, 55
battery bay 16
battery release latches,
identifying 16
bays, battery 16
BIOS administrator password 126
Blu-ray Disc ROM Combo Drive
removal 61
spare part number 30, 36, 61
specifications 138
Bluetooth module
removal 109
spare part number 24, 109
Bluetooth module cable,
illustrated 33
boot options 127
boot order 127
broadband module
spare part number 29
builtin device
ambient light sensor 130
audio device 130
bay device 130
Bluetooth device 130
fingerprint reader 130
infegrated camera 130
internal speakers 130
microphone 130

modem 130

Network Interface Controller
(LAN) 130

options 130

power monitor circuit 130

Woake on LAN 130

wireless button 130

WLAN device 130

WWAN device 130
buttons

power 12

C
cables, service considerations 49
caps lock light, identifying 11
chipset, product description 2
components

additional hardware 19
bottom 16

display 17

front 14

leftside 15

rightside 15

top 10

wireless antennas 18
computer feet

locations 54

spare part number 54
Computer Setup

accessing 122

File menu 124

navigating and selecting 122
restoring factory settings 123
Security menu 126

System Configuration

menu 127

using 122
computer specifications 132
connector, power 15
connectors, service
considerations 49
cord, power 19

D
DC-in cable, illustrated 33

device configurations 128
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discs
Driver Recovery 148
Operating System 148
Disk Sanitizer 126
diskette drive
precautions 49
product description 4
display assembly
removal 89, 96
spare part
numbers
display bezel
removal 92, 99
spare part number 31
display component recycling 157
display enclosure
spare part number 32
Display Hinge Kit, spare part

21, 89, 96

number 32, 94, 101
display panel, removal 94, 101
display specifications 133, 134

drive light, identifying 14
Drivelock
automatic 126
password 126
Driver Recovery disc 148
drives
boot order 127
optical 15
preventing damage 49
DVD-ROM Drive
removal 61
spare part number 30, 36, 61
specifications 136
DVD+RW Double-Layer Drive with
LightScribe
precautions 49
removal 61
spare part number 30, 35, 61
specifications 137

E
electrostatic discharge 50
eSATA/USB port
identifying 16

esc key, identifying 13
Ethernet, product description 4
Execution disable 128
ExpressCard slot bezel,

illustrated 32

164 Index

ExpressCard slot, identifying 16
external media cards, product
description 5
external monitor port
identifying 15

pin assignments 151

F
f11 recovery
feet
locations 54
spare part number 54
File menu 124
finger print reader, product
description 6
fn key, identifying 13
function keys, identifying 13

142, 145

G
graphics, product description 2
grounding equipment and

methods 52

H
hard drive
precautions 49
product description 3
removal 87
spare part
numbers 30, 35, 87
specifications 135
hard drive bracket, removal 88
hard drive recovery 142, 145
HDMI port, pin assignments 152
headphone (audio-out) jack
pin assignments 150
heat sink
removal 78
spare part number 78
hinge, spare part
number 94, 101
HP Quicklook 129
HP QuickLook light,
identifying 11
HP QuickWeb light,
identifying 11

I
internal display switch,
identifying 12, 17

internal microphone,
identifying 17

J

jacks
audio-in (microphone) 14
audio-out (headphone) 14
RI-11 (modem) 15
RJ-45 (network) 15

K
keyboard

product description 6

removal 56

spare part number 23, 41, 56
keypad keys, identifying 13

keys
esc 13
fn 13
function 13
keypad 13

Windows applications 13
Windows logo 13

L
language, changing in Computer
Setup 127

latches, battery release 16
LCD Cable

contents 35

spare part number 35
left TouchPad button 10
legacy support, USB 122, 128
lights

AC adapter 15

caps lock 11

drive 14

HP Quicklook 11

HP QuickWeb 11

optical drive 15

power 11

Quicklook 11

QuickWeb 11

TouchPad off indicator 11

webcam 17

wireless 11

M
mass storage devices, spare part
numbers 35



Media Card Reader,
identifying 14

memory module

product description 3

removal 60

spare part numbers 29, 60
microphone (audio-in) jack

identifying 14

pin assignments 150
Misc LCD Cable Kit

contents 34

spare part number 34
model name 1
modem jack, pin

assignments 153

modem module

product description 4

removal 110

spare part numbers 29, 110
monitor port

external 15

pin assignments 151
Multi Core CPU 129

N

network jack, pin
assignments 154

Num lock state 129

o
Operating System disc 148
operating system, product
description 6
optical drive
identifying 15
precautions 49
product description 4
removal 61
spare part number 30, 35, 61
specifications 136, 137, 138
optical drive bezel, illustrated 32
optical drive extender
spare part number 29
optical drive light, identifying 15

P
packing guidelines 51
palm rest

removal 84

spare part number 23

spare part numbers 84

panels, product description 2
passwords 126
pin assignments
audio-in jack 150
audio-out (headphone)
jack 150
external monitor port 151
HDMI 152
headphone (audio-out)
jack 150
microphone (audio-in)
jack 150
modem jack 153
monitor port 151
network jack 154
R-1T 153
RJ-45 (network) jack 154
Universal Serial Bus (USB)
port 154
plastic parts 48
Plastics Kit
contents 32
spare part number 32
pointing devices, product
description 6
port options
1394 port 131
eSATA port 131
ExpressCard slot 131
flash media reader 131
parallel port 131
serial port 131
USB port 131
ports
eSATA/USB 16
external monitor 15
HDMI 16
product description 5
USB 15,16
power button board
removal 63
spare part number 23
power button, identifying 12
power connector assembly
identifying 15
removal 120
spare part number 120
power cord
identifying 19

set requirements 155
spare part numbers 36, 38
power light, identifying 11
power requirements, product
description 6
processor
product description 1
removal 83
spare part numbers 28, 83
product description
audio 4
chipset 2
diskette drive 4
Ethernet 4
external media cards 5
fingerprint reader 6
graphics 2
hard drives 3
keyboard 6
memory module 3
modem module 4
operating system 6
optical drives 4
panels 2
pointing devices 6
ports 5
power requirements 6
processors |
product name 1

security 6
serviceability 9
wireless 5

product name 1

Q
QuicklLook light, identifying 11
QuickWeb light, identifying 11

R
recovery partition 142, 145
release latches, battery 16
removal/replacement

preliminaries 48

procedures 53
restore factory seftings 124
restore security defaults 124, 131
restoring the hard drive 142, 145
rightTouchPad button 11
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RJ-11 (modem) jack
identifying 15
pin assignments 153
RJ-11 connector assembly
removal 119
spare part number 119
RJ-11 jack cable
illustrated 33
RJ-45 (network) jack
identifying 15
pin assignments 154
RTC battery

removal 107
spare part
number 29, 46, 107

Rubber Kit, spare part number 37

S
SATA (Serial Advanced Technology
Attachment) devices
AHCI (Advanced Host Controller
Interface) 128
IDE (Integrated Drive
Electronics) 128
SATA (Serial Advanced Technology
Attachment) devices) 128
Screw Kit
spare part number 37
security cable slot, identifying 15
Security menu
antitheft Protection 126
Automatic Drivelock 126
change password 126
Disk Sanitizer 126
Drivelock 126
fingerprint reader reset 126
HP SpareKey 126
HP SpareKey enrollment 126
password policy 126
set up BIOS administrator
password 126
System IDs 126
user management 126
security, product description 6
service considerations 48
service tag, location 20, 53
serviceability, product
description 9
set security level 131
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setup utility
File menu 124
navigating and selecting 122
restoring factory settings 123
Security menu 126
System Configuration
menu 127
SIMslot 16
slots
ExpressCard 16
security cable 15
speakers
identifying 12
removal 65
spare part number 23, 65
specifications
Blu-ray Disc ROM Combo
Drive 138
computer 132
display 133, 134
DVD-ROM Drive 136
DVD+RW Double-Layer Drive
with LightScribe 137
hard drive 135
optical drive 136, 137, 138
static-shielding materials 52
switch cover
removal 56
spare part number 23, 56
system board
removal 114
spare part number 24
spare part numbers 24, 114
System Configuration menu 127
system date and time 124
system diagnostics 124
system fan 128
system IDs 126
system information 124

T
thermal material, replacement 80
thermal shield

removal 67

spare part number 67
tools required 48
top cover

removal 103

spare part number 23, 103
TouchPad, identifying 10

TouchPad, light 10
transporting guidelines 51

)
Unified Extensible Firmware
Interface (UEFI) mode 129
USB connector assembly
removal 117
spare part number
USB legacy support
USB port
identitying 15, 16

pin assignments 154

117
122,128

\"
vents, identifying 15

Virtualization Technology 129

w
wake on USB 129
webcam light, identifying 17
webcam module, spare part
number 31, 41
webcam, identifying 17
Windows 7 operating system
DVD 142
Windows applications key,
identifying 13
Windows Backup
utility 147, 148
Windows logo key,
identitying 13
Windows
recovery 141, 144, 148
Windows Vista operating system
DVD 146
wireless antenna,
disconnecting 74, 76
wireless light, identifying 11
wireless, product description 5
WILAN antennas, identifying 18
WLAN module
removal 70
spare part numbers 24, 70
workstation guidelines 51
WWAN antennas, identifying 18
WWAN module
removal 76
spare part number 76
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